Microsoft® Windows
for Pen Computing 1.0

User’s Guide







Guide to Pen Computmg

Microsoft

WINDOWS

HORPEN
(OMPUTING




Information in this document is subject to change without notice and does not represent a
commitment on the part of Microsoft Corporation. The software, which includes information
contained in any databases, described in this document is furnished under a license agreement
or nondisclosure agreement and may be used or copied only in accordance with the terms of
that agreement. It is against the law to copy the software except as specifically allowed in the
license or nondisclosure agreement. No part of this manual may be reproduced or transmitted
in any form or by any means, electronic or mechanical, including photocopying and
recording, for any purpose without the express written permission of Microsoft Corporation.

Copyright Microsoft Corporation, 1992. All rights reserved. Printed in the United States of
America.

Microsoft and MS-DOS are registered trademarks and Windows and the Windows logo are
trademarks of Microsoft Corporation.
Paintbrush is a trademark of ZSoft Corporation.

Document Number WGPENW-0392




Contents

Welcome xi

Roadmap to Microsoft Windows for Pen Computing Documentation  xi
About This Book  xii

PART1 Getting Started

Chapter 1

Learning to Use the Pen 1

Before You Begin 2
What’s on the Screen? 2
Pen Techniques 3
Working with Program Manager 4
Minimizing Program Manager 4
Restoring Program Manager 5
Moving the Program Manager Window 5
Sizing the Program Manager Window 6
Starting Applications from Program Manager 6
Working with the Sample Form Application 7
Starting an Application 7
Writing in an Application 8
Printing in Letter Guides 9
Writing over Errors in Letter Guides 10
Writing Without Letter Guides 11
Using Gestures to Correct Text 12
Editing Text 13
Inserting a Space 14
Selecting Text 15
Cutting Text 16
Selecting and Replacing Text 17
Closing the Sample Form 17
Summary 18
Working with the Pen Palette 18
Restoring the Pen Palette 18
Pen Palette Tools 19
Minimizing the Pen Palette 22
Summary 23
Getting Online Help 23
Using Help Contents 23
Viewing Definitions 25

Guide to Pen Computing




iv Contents

Viewing a Help Topic 26
Returning to Help Contents 27
Searching for Help Topics 27
Exiting Help 28
Help Notes 29
Summary 29

Where Do I Go from Here? 30

PART 2 Using the Pen

Chapter 2 Writing and Correcting Text 33

Methods for Writing in Applications 33
Writing Tips 33
Writing in an Application 35
How Does Handwriting Recognition Work? = 35
Writing in a Text Box 36
Correcting Text 37
Selecting and Replacing Text 37
Using the Edit Text Dialog Box 38
Using the Pen Palette 40
Restoring the Pen Palette 41
Working with the Writing Window 41
Correcting Text in the Writing Window 43
Using the On-Screen Keyboard 45
Minimizing and Closing the Pen Palette 46
Minimizing the Pen Palette 46
Closing the Pen Palette 47

Chapter 3 Using Gestures 49

Help on Gestures 50
The Learning Pen Basics Tutorial 50
Using Predefined Gestures 52
Basic Editing Gestures 52
Edit Text 52
Backspace 53
Insert Space 53
Insert New Line 54
Cut 54
Undo 55
Additional Gestures 56
Copy 56
Paste 56
Delete 57

Guide to Pen Computing




Contents v

Delete Word 57
Extend Selection 58
Insert Tab 58
Defining Your Own Gestures 59
Predefined Circled-Letter Gestures 59
Creating a Gesture 60

Chapter 4 Training the Recognizer 63

Using the Trainer 63
Customizing the Recognition Database 66

Chapter 5 Getting Help 67

How Windows Help Is Organized 67

Using Help Notes 68

Using Help Contents 68
Scrolling Through Help 69
Viewing Help Topics 70
Viewing Definitions 71

Using Help Buttons 72

Searching for Help Topics 73
Help on Help 74

Exiting Help 74

PART 3 Using Windows

Chapter 6 Microsoft Windows Basic Skills 77

Using Program Manager 78

Starting Applications 79

Working with Windows 80
Moving Between Windows 81
Moving and Sizing Windows 85

Choosing Menus and Commands 86
Tapping to Choose Menus and Commands 86
Selecting and Choosing 87

Using Dialog Boxes 88

Saving Documents and Files 89

Exiting an Application 90

Chapter 7 Customizing Microsoft Windows 91

Changing Pen Settings 92
Changing Ink Settings 93
Changing Double-tap Settings 93

Guide to Pen Computing




vi Contents

Adjusting Press and Hold Delay 94
Changing Handwriting Settings 95

Changing Writing Hand and Menu Style 95

Working with the User Options 96

Adjusting Recognition Time 96

Control Panel Help 97

Calibrating the Pen 97

Rotating the Windows Display 97

Choosing Recognizers and Dictionaries 98

Using International Settings 98

Chapter 8 Managing Microsoft Windows 99

Using Program Manager 99
Creating a Group Window 100
Exiting Program Manager 102
Program Manager Help 103

Using File Manager 104
Starting File Manager 104
Viewing Directory Contents 106
Searching for Files 108
Copying and Moving Files 109
File Manager Help 111

Using Print Manager 111
Activating Print Manager 111
Checking Printer Status 113
Print Manager Help 113

Chapter 9 Using Microsoft Notebook 115

Starting Microsoft Notebook 116
Moving Around in Notebook 118
Using the Table of Contents 118
Using the Navigation Bar 119
Writing and Drawing in Notebook 120
Erasing Ink 121
Recognizing Handwriting 122
Recognizing Drawings 123
Working with Text 124
Editing Text 124
Selecting Text 125
Finding Text 126
Changing Fonts and Styles 127
Undoing the Last Action 128
Performing Calculations 128

Guide to Pen Computing




Contents

vii

Appendix

Working with Pages 129
Adding a Page 130
Naming a Page 131
Organizing Pages 132
Moving a Page or Group of Pages 136
Deleting a Page 137
Working with the Calendar 138
Displaying Month View 139
Working with Objects 140
Moving Objects on a Page 140
Changing the Size of an Object 141
Help with Objects 142
Printing a Notebook Page 143
Quitting Notebook 144

Improving Handwriting Recognition 145

Punctuation 145
Printing Accented Characters 145

Glossary 151
Index 161

Guide to Pen Computing







Welcome

Welcome to Microsoft Windows for Pen Computing, software that combines the
familiarity of the pen with the power of the computer.

Here you use a pen to choose icons and menus instead of typing commands. To edit
your work, you’ll draw special symbols called gestures. Windows for Pen
Computing recognizes your handwriting, so you don’t need a keyboard to print in
forms, take notes, or write documents. And Windows for Pen Computing is portable,
so you can work standing up or walking around—any way that fits your job.

Roadmap to Microsoft Windows for Pen Computing
Documentation

The following illustrations represent the main pieces in the Windows for Pen
Computing documentation package. Although the arrangement suggests a direction
to follow, read the description of each piece and choose the path that best suits your
preferred way to learn.

Start with this book. Chapter 1, “Learning to Use the
Pen,” will get you acquainted with the look and feel of
your pen system. Spend less than an hour and you’ll be
ready to start work.

Follow the Learning Pen Basics online tutorial. The
demonstrations show you how to draw gestures and print
characters. For more information, see Chapter 3, “Using
Gestures,” in this book.

Chapter 6, “Microsoft Windows Basic Skills,” will give
you reference material on Windows basics such as moving
windows and choosing commands.

Online Help contains complete documentation for
Windows for Pen Computing. When you need an answer
and you need it fast, you can get it from online Help. For
more information, see Chapter 5, “Getting Help,” in this
book.

The handy Quick Reference Card provides information on
the pen tools and tips on how to draw gestures. Carry it
with your computer case. Use it when you need a quick
reminder.
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X Welcome

About This Book

The Guide to Pen Computing introduces Microsoft Windows for Pen Computing.
This book shows you how to get started with pen computing, and refers you to online
Help, which contains complete documentation for Windows for Pen Computing.

This book is arranged as follows:
m Chapter 1, “Learning to Use the Pen”

Contains hands-on practice sessions covering basic pen techniques, such as
working with windows, writing and correcting text, and getting Help.

m  Chapter 2, “Writing and Correcting Text”
Explains the pen part of Windows for Pen Computing.
m  Chapter 3, “Using Gestures”

Shows you how to draw special symbols that carry out Windows commands and
how to create your own gestures.

m  Chapter 4, “Training the Recognizer”

Shows you how to improve recognition of your handwriting by training the
handwriting recognizer.

m  Chapter 5, “Getting Help”
Shows you how to use Help and how to search for the information you need.
®  Chapter 6, “Microsoft Windows Basic Skills”

Covers fundamental Windows tasks, such as working with multiple windows,
choosing commands, using dialog boxes, and getting Help.

m Chapter 7, “Customizing Microsoft Windows”

Shows you how to use the Control Panel to customize handwriting and pen
settings.

m Chapter 8, “Managing Microsoft Windows”

Introduces Program Manager, File Manager, and Print Manager, and shows you
how to use them to manage applications, files, and printers.

m  Chapter 9, “Using Microsoft Notebook™

Shows you how to use the Notebook accessory to organize and manage
information.

®  Appendix, “Improving Handwriting Recognition”

Provides information and examples on how to print characters to improve
handwriting recognition.

m  Glossary

Defines terms specific to Windows for Pen Computing.

Guide to Pen Computing
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Learning to Use the Pen

This chapter provides descriptions, explanations, and practice sessions to help you
learn how to use the pen and feel comfortable with it.

Beginning Windows Users

To become skilled with basic pen techniques, follow every step in this chapter. It
takes about 35 minutes to complete. Later chapters will provide more detailed
information about the basics you'll learn here.

Experienced Windows Users

Using Windows with a pen is very much like using Windows with a mouse. For
example, to choose a command with the mouse, you point to the command and click
the left mouse button; to choose a command with the pen, you tap the command. If
you are experienced using any Windows application with a mouse, you'll find that
many aspects of Windows for Pen Computing will be familiar, and this chapter will
get you going quickly.

Use this chapter to practice:

®m  Pen techniques

m  Working with Program Manager

®m  Working with the Sample Form application
m  Using gestures to correct text

m  Working with the Pen Palette

m  Getting online Help

Guide to Pen Computing




2 Part1 Getting Started

Program Manager ——

Before You Begin

To follow this tutorial, you must first start Microsoft Windows. After starting
Windows, you should see a screen similar to this:

DA a il d(t Wi A

File Options Window Help

,Mlcr.:)soﬂ = TOOIS R

¢ ®

Notebook Pen Palette  Learning  Sample Form

Microsoft Pen Tools

Pen Palette icon
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Pen Basics
<§“_"? IEI
On-Screen Trainer
Keyboard

—

Pen Palette

What's on the Screen?

When you start Windows for Pen Computing, Program Manager, the Pen Tools
window, and the floating Pen Palette icon (below, to the left) are displayed on the
screen.

Program Manager and the Microsoft Pen Tools Group

You use Program Manager to start, arrange, and work with the software, or
applications, you have on your computer system. Program Manager displays
application icons (graphical representations of applications) in group windows. For
example, Program Manager displays icons for the pen tools in the Microsoft Pen
Tools group window. Later, you’ll learn how to work with the icons in group
windows. (A group window is one that displays related application icons.)

The Pen Palette Icon

The Pen Palette is a floating palette of writing tools that is displayed at the bottom of
the screen whenever you start Windows for Pen Computing. You can use the Pen
Palette and its tools with any of your applications, but its main purpose is to provide
a way for you to write in applications that do not accept handwriting directly.
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Pen Techniques

Working with Windows for Pen Computing is easy when you learn three basic pen
techniques: tapping, dragging, and selecting. In the next sections, you’ll practice
these techniques.

Tap

%Iilelxltl TR R T SR T R

|;l 1 L 1 | 1 1 1 1 |

Drag
e ——

m  Tap an object to choose it.

To tap an object, you press the pen tip down on the object, and then lift the pen tip
up. Don’t be afraid to apply some pressure. To use this technique to shrink a window
to an icon, for example, you tap the Minimize button in the upper-right corner.

To choose shortcuts, double-tap an object. For example, to restore a window to its
previous size, you double-tap the window’s icon. To double-tap an object, tap it
twice quickly in the same location.

®m  Drag an object to move or resize it.

To drag an object, press and hold down the pen tip while you move it in the direction
you want to drag the object. To move a window, drag its title bar. To enlarge or

reduce a window, drag its border. Lift the pen when the object reaches the desired |
location or size. |

®  Select an object to act upon it.

To select text, you press and hold the pen tip at the beginning of the text you want to
“ select. When you see a blinking bar and an arrow pointer, drag the highlight or

underline until it covers or underlines everything you want to select. You'll use this
technique, for example, when you select a word to be deleted.

Guide to Pen Computing
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4 Part1 Getting Started

Working with Program Manager

Guide to Pen Computing

When you start Microsoft Windows, the Program Manager window occupies a
central position on your screen. Using pen techniques described in this chapter, you
can change the location and size of Program Manager and place it anywhere you
want.

In this section, you’ll practice these techniques with Program Manager:
®  Minimizing

m  Restoring

m  Moving

m  Sizing

Minimizing Program Manager

To minimize the Program Manager window, you tap the Minimize button to shrink
the window to an icon at the bottom of the screen. Doing this reduces the clutter on
your screen and makes it easier for you to move between open windows.

To minimize Program
Manager, tap here.

— Frogra anage Via

File Options Window Help

Microsoft Pen Toolé

< ® £

Notebook Pen Palette ~ Learning ~ Sample Form

Pen Basics

On-Screen Trainer
Keyboard
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Title bar

Program Manager ——

Restoring Program Manager

When you want to work with a window that's been minimized, you restore the
window to its previous size by double-tapping its icon or the icon label at the bottom
of the screen.

To restore Program Manager,
double-tap this icon.

Prograanager

Moving the Program Manager Window

You move the Program Manager window or its icon by dragging them on the screen.
This is especially useful when you want to copy information between two windows
and you want to see both windows on the screen at the same time.

To move Program Manager,
drag the title bar. An outline of
Program Manager follows the pen tip.

When the outline is where you
want Program Manager to be,
lift the pen.

.

e ———

(L1

1% e
1 [Le

=}
oneon
A

g = B ) — 2 P - L - S S—
vo A 40 Ao

Main  Applications ~ Accessories  Games  StartUp
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6 Part1 Getting Started

Sizing the Program Manager Window

You can change the size of the Program Manager window by dragging its borders.
Do this when you want to keep the Program Manager open, but you don’t want it
taking up a lot of screen space.

To shrink Program Manager,
drag a window border.

Program Man?ger
File Options Window Help

Program Manager
UUtIine SEesaAEENERERRERENER sssanm SRR ERNERERSR
= ) S4d4 Sd4 a4 .4
Program Manager A¥D A¥D A¥® ~Ja¥s
Main  Applications  Accessories | Games Starmb\
When the outline is about
this size, lift the pen.
Starting Applications from Program Manager
You use Program Manager to easily find, start, and work with multiple applications.
The next section explains how to use Program Manager to start an application.
Guide to Pen Computing



Chapter 1 Learning to Use the Pen 7

Working with the Sample Form Application

An application is a computer program that is used for a particular kind of work, such
as word processing or inventory management. The next series of steps gives you the
chance to practice working in the Sample Form.

Starting an Application

The easiest way to start an application is to double-tap its icon. The Sample Form
application icon is located in the Microsoft Pen Tools group window (displayed in
Program Manager when you open the Windows environment).

To open the Sample Form,
/) double-tap its icon.

1]

Microsoft Pen Tools —

Notebook Pen Palette  Learning  Sample Form

Pen Basics

£ B

On-Screen Trainer
Keyboard
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8 Part1 Getting Started

Guide to Pen Computing

Wiriting in an Application

Windows indicates where you can write in an application by displaying a pointer
shaped like a pen when the pen tip is near a writing area. You can print anywhere
you see the pen-shaped pointer.

= Sample Form
File

Name:

| | ! ! 1 | 1 1 1 1 1 ! 1 1 1 J

Address:

Notes:

You can print
wherever you
see the pen
pointer.

You see an arrow pointer when you move the pen outside of a writing area. The
arrow pointer indicates areas where you can use the pen to manipulate windows or
choose buttons, menus, and commands.
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Printing in Letter Guides

Letter guides are boxes that you print in to make it easier for the computer to
recognize your handwriting. The illustration shows you how to print in the letter
guides in the Sample Form.

— Sample Form
File
To enter text,
Name: print "John
; Smith" in the
|Jlolhlnl |S|m|‘ I.rlhl L1 L ] letter guides.
Address: |= Sample Form
File
Notes: Name:
IJ|O|h1n| IS|mIiItIhI 1 1 | | |
Address:
Notes:

After you lift the pen, the printed
handwriting is recognized as text.

Don’t be concerned if you see errors—the next exercise shows you how to correct
them.

Guide to Pen Computing




10 Part1 Getting Started

Writing over Errors in Letter Guides

Occasionally, you'll print characters that are not recognized exactly as you wrote
them. Sometimes you'll see an incorrect character or a question mark instead of the
character you printed. Fortunately, these errors are easy to fix—you can correct
errors in letter guides by printing over them.

Chapter 2 describes how to print characters that are easy to recognize. In Chapter 4,
you'll see how you can use the Microsoft Trainer to train the computer to better
recognize your printing style.

For now, you can print over any incorrect characters in the letter guides.

Don’t be concerned if you have to rewrite a letter a couple of times before it’s
recognized correctly. After you get a feel for the writing surface and practice
printing a little more, you’ll see fewer recognition problems.

To correct errors or unrecognized
characters, write over them.

NarJ\e:

|\?'1 hlnl |S|m|i|t|h| 1 1 1 I |

Addres /

Sample Form

Recognized text

Guide to Pen Computing
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Wiriting Without Letter Guides

Some writing areas, especially those that contain space for notes, may not contain
letter guides. Keep the following in mind when you print in these “unguided” areas:

= Print neatly.
m  Keep characters separate.
®  Print uppercase larger than lowercase.

The following illustration shows you how to print in two writing areas that do not
use letter guides.

Sample Form
File
Name:
[J,O,h,ﬂ, ISlmIiltlhl 1 1 | 1 J
Address:
365 Broadway Print "365
Broadway" in
Notes: the Address
box.
Office supplies
Print "Office
Supplies” in
the Notes box.

Don’t worry if you see errors—they 're easy to fix.

In the next section, you’ll see how you can use the Edit Text gesture to correct
printing errors.

Guide to Pen Computing
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Using Gestures to Correct Text

In Pen Computing, a gesture is a special symbol you draw to tell Windows to carry
out an action. For example, when you draw a checkmark over a word, Windows
recognizes it as the Edit Text gesture (and not as text) and displays the word in the
Edit Text dialog box.

You can draw gestures anywhere you can print text.

The next section shows you how to use three gestures: Edit Text, Insert Space, and
Cut.

Note The arrows next to the gestures indicate the direction to draw the gestures.

Action Gesture How To Use It

Edit Text \\é To display selected words in the Edit Text
dialog box, draw a checkmark through the
selection.

Insert — To insert a blank space, draw a line

Space > down and to the right.

Cut 9 }ﬂ To cut text, draw a looping line, up and
to the right.

These are only three of the gestures that come with Windows for Pen Computing.
For a complete list of gestures, see the Pen Computing Quick Reference Card or
Chapter 3, “Using Gestures,” in this guide.

Guide to Pen Computing
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Editing Text

To edit text, draw the Edit Text gesture (a checkmark) through the word, text, or
number you want to correct. The Edit Text dialog box will appear. The dialog box
contains letter guides that make it easy to make text corrections. Make your
correction (by printing over the error) and tap the OK button to return to the Sample

Form.

The illustration shows you how to change the existing street number in the address.
Use the same steps to correct any other errors in your form.

= Sample Form
File

To edit a word

or number,

Name:

[J|O|h|n| |S|m|i|t|h| | | 1 1 J
Address:

3% Broadway

Notes:

draw a check-
mark through it.

4+ OK ]

llI|||IlIIIl|‘,W'

Cancel I

The word or number appears in
the Edit Text dialog box.

Guide to Pen Computing




14 Part1 Getting Started

Inserting a Space

You can also draw the Insert Space gesture anywhere you can print, such as directly
in the Sample Form application. The illustration shows you how to use the Insert
Space gesture to add a blank space in the letter guides of the Edit Text dialog box.

Tip Draw the horizontal “tail” of the gesture longer than the downward part.

To insert a space, draw
the Insert Space gesture.

3 6' + ok |
[Ty LS 1 T I T [
Insert Space N [ cancel |
gesture L o wli dit Te
1 OK !
l3 L 6 I 5 I, PR TN NS S AN AN |
T Cancel i

L [, TS NN NN, VSN (NN VAN | (N (M |
'

Wiriting over Text

You can write over text to correct it in the Edit Text dialog box, just as you can in
any writing area that contains letter guides.

'To correct errors in letter guides, write over them.

d

I3|6|?|gm\ i i 4 4 4 a 1 .
[_cancel |

| I S I [ T T |
| AT T T | 1 [ll[{[_Help—|

Print a "7" here. | Printan "8" over the "5."

Guide to Pen Computing
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Selecting Text

With most commands, before you can choose the command, you must select the text
you want to use with the command. For example, to cut text, you first select the text
you want to cut and then choose the Cut command or draw the Cut gesture.

To select text, as already noted, you press and hold the pen tip at the beginning of
the text you want to select. When you see the flashing bar and the arrow pointer,
keep the pen tip down and drag it until the highlight covers all the text you want to

select.
Sample Form
File
Name:
LJ10|h|n| ISImIiItIhI | | 1 L |
Address: Y
365 Broad

To select text, tap and hold the pen tip at
the beginning of the "w." When you see the
flashing bar and the arrow pointer, drag
the pen tip until it covers the "y." After you
lift the pen, the selected text is highlighted.

Guide to Pen Computing




16 Part1 Getting Started

Cutting Text

Cutting text is similar to erasing text, except that the text you cut is temporarily
stored on the Clipboard. This makes it easy to recover text, if you want it back or
decide to move it elsewhere.

= Sample Form
File
Name:
|J|O|h|n| ISImIiltIhl | | 1 [
Address: To cut
selected text,
365 Broa draw the Cut
_________________ gesture over
__________________________________ the selection.
Address:
365 Broad |

The selected text is cut.

Guide to Pen Computing
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Selecting and Replacing Text

You can replace text by selecting the text you want to replace and then printing the
new text. When the new text is recognized, it replaces the selected text.

= Sample Form
File
Name:
LJlolhlnl |S|m|i1t|h| 1 1
Address:
365 Broadway
Notes:
. : Toreplace a
supphes word, select it,
and then print
Co mp M.\_e,( the new word.

Closing the Sample Form

After finishing with the writing practice, close the Sample Form. When you close it,
any changes you have made to the form are erased—they are not saved with the
form. To close the form, choose Exit from the File menu.

A 1. To open the File
menu, tap here.

2. To close the practice form, choose
Exit from the File menu.

Se/nple Form

A /
Er—

Exit

Guide to Pen Computing
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Summary

The four preceding sections of the tutorial showed you how to:
m Do three basic pen techniques

m  Work with Program Manager

m  Work with the Sample Form application

m  Use gestures to correct text

The next section shows you how to work with the Pen Palette.

Working with the Pen Palette

Guide to Pen Computing

The Pen Palette is a floating palette of writing tools available whenever you start
Windows for Pen Computing. You can use the Pen Palette with any application, but
its primary purpose is to help you write in applications that otherwise do not accept
handwriting.

Restoring the Pen Palette

When you start Windows, the Pen Palette is minimized at the bottom of the screen.
To restore the Pen Palette and use its tools, you double-tap the Pen Palette icon.

To restore the Pen Palette,
double-tap the icon or label.

Pen Palette
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Pen Palette Tools

The Pen Palette tool bar contains a set of writing tool buttons. The table below tells
you what each tool does; the exercises that follow show you how to use some of

them.

Tool bar

Pen Palette tool

What it does

Edit menu

Writing window button

On-Screen keyboard button

Trainer button

Clear button
OK button

Help button

Displays commands for editing text in the
writing window and for customizing the Pen
Palette.

Opens and closes the writing window.

Opens the on-screen keyboard. Use the on-
screen keyboard when you want to insert a lot
of numbers or characters that you’re having
problems writing.

Displays a tool for improving handwriting
recognition. The trainer is also available as an
icon in the Microsoft Pen Tools group window.
See Chapter 4, “Training the Recognizer,” for
details.

Erases all text in the writing window.

Sends recognized text from the writing window
to the active application.

Displays online Help commands.

Guide to Pen Computing
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The Edit Menu

The Edit menu contains commands for editing text in the writing window and for
customizing the Pen Palette.

1. To choose the Edit menu,
tap the Edit menu button.

2. To close the Edit
menu, tap anywhere
outside the menu.

Edit menu button

Edit meny ————

Options...
Gesture Manager...

The Writing Window

When you print in the Pen Palette writing window, Windows recognizes your
handwriting and translates it into text. The translated text stays in the writing
window until you choose another place to insert the text.

When you’re not working with the writing window, you can close it and leave the
Pen Palette tool bar open.

1. To close the writing window,
tap the Writing window button.

2. To open the writing window,
tap the button again.

Tool bar ——{ |

Writing window

Guide to Pen Computing



Chapter 1 Learning to Use the Pen 21

On-screen
keyboard

The On-Screen Keyhoard

You use the on-screen keyboard to “type” text in the writing window. To “type,” you
simply tap the letter you want. The on-screen keyboard is useful when you are
entering a lot of numbers, or when you are having problems writing.

Practice “typing” letters and numbers with the on-screen keyboard. Don’t worry if
you make a few mistakes; you’ll see how to correct them later.

y

1. To open the on-screen keyhoard, tap the
On-screen keyboard button.

B —
Restore
Move E e o
Minimize
Options IB |7 la |9 T |- |+B=<k; oz ffim fPa | [Fonl?

& Dol fEndfirg | [Hm f + [Po [+

Close Alt+F4

EEIIIHIIIIIII I EHE
G Shift E 7 oshin F Endf ¢ [Pa fent]
Curl |mz l IAI( l Crl | «M+0- I Inz Dnll

2.To close the on-screen keyhoard, choose
Close from the Control menu.

Guide to Pen Computing
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Clearing Text in the Writing Window
To clear away the practice text you “typed” with the on-screen keyboard, you tap the
Clear button on the Pen Palette tool bar. ,

/4 To clear all text, tap
/| the Clear button.

The Pen Palette writing —
window is cleared of all
text.

Minimizing the Pen Palette

When you are finished using the Pen Palette tools, you can minimize the Pen Palette
(that is, shrink it to an icon at the bottom of the screen).

/// To minimize the
Pen Palette, tap
here.

Pen Palette

Pen Palette icon ———@

Pen Palette

Guide to Pen Computing
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Summary

This part of the tutorial showed you how to:

m  Restore the Pen Palette from an icon at the bottom of the screen
m  Recognize the tools on the Pen Palette tool bar

®  Use the writing window to write text in applications that do not directly accept
handwriting

m  Use the on-screen keyboard to type text

= Minimize the Pen Palette and return it to its position as an icon at the bottom of
the screen

Getting Online Help

This is the last section of this tutorial. Follow it carefully to learn how to use online
Help. Online Help is very important, because most of the instructions on how to use
Windows for Pen Computing are in the online Help topics.

Using Help Contents

The Pen Palette Help Contents screen displays the Pen Palette Help topics, grouped
according to related tasks and information.

/} 1. To get Pen Palette Help,
tap the Help button.

H— 2. To view Help Contents,
Search for Help on... = tap Contents.

How to Use Help...

L About Pen Palette... ||

Guide to Pen Computing




24 Part1 Getting Started

Scrolling Help Contents

Help contains more topics than you can see in the first Help Contents screen. To see
the rest of the topic titles, use the scroll button and scroll bar to move throu_gh the
contents.

= Pen Palette Help [ v]a]
File Edit Bookmark Help

(_)ontentsi Search Jéack l History j _gisturesjgﬂBasics

Pen Palette Help Contents

Pen Palette Help

4

To view a help topic, tap one of the underlined topic names below.

Basic Skills

Help Basics

What is the Pen Palette?

How to Use the Pen

Moving and Sizing the Pen Palette

Writing and Correcting Text
Using the Writing Window
Editing Text
Reversing the Previous Action
Moving and Copying Text

— To scroll a lot, tap
the scroll bar.

+— To scroll a little, tap
the scroll button.

Guide to Pen Computing
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Viewing Definitions

Definitions display more information about a term or important concept. Each
definition is marked with a dotted underline.

= Pen Palette Help ﬂ_ Al
File Edit Bookmark, Help

Qontentsl Search l Back l History chiestures Igen Basics

Pen Palette Hely/ Contents

Pen Palette Help

To view a help topic, taZ one of the underlined topic names below.

Tap

Definition box

i« To close a definition

To press the pen tip against the screen and lift the pen tip up. | box, tap it.

~HeIp Gasits .
What is the Pen Palette?
How to Use the Pen

Moving and Sizing the Pen Palette

Writing and Correcting Text
Using the Writing Window
Editing Text
Reversing the Previous Action
Moving and Copying Text
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Viewing a Help Topic

Each underlined Help topic displays more information when you tap it.

Pen Palette Help [v]a]
File Edit Bookmark Help

_gontents I Search l Back I History I Gestures I_F_’en Basics
Pen Palette Help Contents

Pen Palette Help

To view a help topic, tap one of the underlined topic names below.

[Basic Skills — Toview atopic,
. tap it.

Help Basics

What is the Pen Palette’?

How to Use the Pen

Moving and Sizing the Pen Palette

Topics

Writing and Correcting Text
Using the Writing Window
Editing Text

Reversing the Previous Action
L Moving and Copying Text

¥

When you choose the “What is the Pen Palette?” topic, the following screen appears:

Pen Palette Help [v[al
File Edit Bookmark Help

Qontents] Search l _Back | History ] @estures]Een Basics
What is the Pen Palette?

Pen Palette Help

The Pen Palette is a palette of tools-including a writing window, £
trainer, on-screen keyboard, and Gesture Manager--that you use

when writing. The Pen Palette initially displays as an icon when you
start Windows.

Tap any part of the drawing below to learn about each tool and its
function.

See also:

Guide to Pen Computing
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Returning to Help Contents

All Help windows contain Help buttons that remain visible when you’re reading a
topic. Tapping the Contents button displays the Help Contents screen.

To return to Pen Palette
Help Contents, tap the
Contents button.

Pen Palette Help
File // Edit Bookmark Help
_gorfents l __ Search I__gack l History I _Gestures lEen Basics
What is the Pen Palette?
________________________________________________________ [ el

Pen Palette Help

Searching for Help Topics

Tapping the Search button displays the Search dialog box, which you use to find
Help topics and their related terms.

1. To display the Search dialog
box, tap the Search button.

/_Pen Palette Help
Edit Bgbkmark Help

Pen Palette Help ——— File

————————— n : 2. To scroll to
ype a word, or selecfone from the list. " "
Then chose Show Tofjics. the gesture;
keyword, print

"

a"g” here.

gesture list
gesture mapping
gesture settings
go back

handwriting

N~ 3.To display related
topics, tap Show
Topics.

Search dialog box

Select a topic, then choose

Using Predefined Gestures

4. To view a topic, double-tap it or tap
the topic and then choose Go To.
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When you choose the Predefined Gestures, Help displays the following topic:

= Pen Palette Help [v]a]
File Edit Bookmark Help

Qontentsl Search l Back l History l _Gestures lgﬂBasics

Using Gestures

Pen Palette Help

A gesture is a special handwriting symbol you draw to tell |2
Windows to carry out an action.
For more information, tap any gesture.

v X = = 7

EDIT TEXT BACKSPACE  SPACE MEWY LIME CuT U

o A % == ‘IT
COPY PASTE DELETE DELETE WWORD EXTEMND T

To see a demonstration of how gestures are drawn, and
to practice drawing text and gestures, tap the button
below.

Tip A quick way to display this topic is to tap the Gestures button.

Exiting Help

After viewing Help topics, close Help by choosing the Exit command from the File
menu. You’ll be returned to wherever you were when you tapped the Help button.

Pen Palette Help
Edi}, Bookmark Help
o | Back ] History J _Gestures Pen Basics

ette

Pen Palette Help

To exit Pen Palette Help,
choose Exit from the File menu.
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Help Notes

It’s important to know how to get Help when you need more information. To make it
easier to find specific Help topics, each section in the rest of this guide contains Help
notes that show you where to find more information in Help. Here is an example.

vv +  Forinformation on: The on-screen keyboard
ﬁ%ﬁ g% See Help file: Pen Palette Help |
) Topic: Writing and Correcting Text |

Using the On-Screen Keyboard
~ Search for: Keys

This Help note shows you the following:
®  There is more information about the on-screen keyboard in online Help.
®  The information is in the Pen Palette Help file. |

You must be using the Pen Palette to find information in Pen Palette Help. The |
same is true for any other Help file—you must be using the application that the |
Help file is associated with before you can use its Help. For more information on

using Help files, see “How Windows Help Is Organized™ in Chapter 5, “Getting

Help.”

®  You can find the On-Screen Keyboard topic in the Pen Palette Help Contents
screen by looking under the “Writing and Correcting Text” or “Using the On-
screen Keyboard” headings.

®  You can also find the On-Screen Keyboard topic by using the Search command |
to find the keyword “keys.” i
|

Summary

Online Help contains most of the documentation for Windows for Pen Computing.
(It also shows you how to use Help to get information about the Pen Palette.)

This section has covered the basic methods for using online Help.

Guide to Pen Computing
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Where Do | Go from Here?

Guide to Pen Computing

If you’ve completed all the exercises in this tutorial, you probably feel comfortable
printing on your computer’s writing surface and confident of your ability to use the
pen.

If you need more practice, follow the tutorial again or experiment with the Pen
Palette and the Sample Form. Tap and double-tap icons and buttons and try writing
in different areas. Get Help and scroll through the topics. If you have games on your
system, play them. The more you practice with the pen, the easier it is to master it.

The following list describes the remaining chapters in this guide. If you’re new to
computers, you’ll probably want to read the chapters in order. If you’re an
experienced computer user, you may want to concentrate on the chapters pertaining
to Windows for Pen Computing.

m  Chapter 2, “Writing and Correcting Text”
More information on writing and editing techniques
m  Chapter 3, “Using Gestures”
Tips on how to use the special symbols
m  Chapter 4, “Training the Recognizer”
Ways to improve handwriting recognition by training the recognizer
m  Chapter 5, “Getting Help”
More information about Help
m  Chapter 6, “Microsoft Windows Basic Skills”

Information on how to choose commands, use dialog boxes, and work with
windows

m  Chapter 7, “Customizing Microsoft Windows”

Information on how to use the Control Panel to customize handwriting and pen
settings

m  Chapter 8, “Managing Microsoft Windows”
More on Program Manager, File Manager and Print Manager
m  Chapter 9, “Using Microsoft Notebook™

Introduction to the Notebook accessory









Wiriting and Correcting Text

This chapter explains how to:

= Improve handwriting recognition

m  Write directly in an application
m  Correct text

m  Use the Pen Palette to write in applications that do not otherwise accept ‘
handwriting

B Minimize and close the Pen Palette

Methods for Writing in Applications |

The method you use to write in an application depends on the application. Most |
Microsoft Windows applications work with the pen and you can print directly in

them. Other applications, however, do not accept direct pen input. For those

applications, you must use the Pen Palette writing window. For more information,

see “Using the Pen Palette,” later in this chapter.

Writing Tips

When you print characters, your handwriting is compared to the sample characters
and symbols in the Microsoft Alphanumeric Recognition System. After you lift the
pen and pause for a moment, the recognizer translates your handwriting into text.

Occasionally, you print characters unlike any of the samples used by the recognizer.
In such cases, the recognizer will translate the text incorrectly or display a question
mark. You can improve handwriting recognition by doing the following:

=  Print neatly. Write each character clearly.

m  Use the letter guides. The letter guides in the Edit Text dialog box and the Pen
Palette writing window help improve handwriting recognition. Until you have
some experience with pen computing, print in the Edit Text dialog box or the Pen
Palette.
\
|
|
:
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Pen Palette

s

1Al[x]od [2]

|Sialml'plllel |+|e|X|

Letter guides

Guide to Pen Computing

Print uppercase characters larger than lowercase characters. The recognizer
compares a character to its surrounding characters and uses character size and
position to determine the case. For example, the recognizer identifies an
uppercase “P” when the letter is larger than the characters that follow it. If the
“p” is not larger than the surrounding text, and the vertical stroke of the letter
descends below the bottom of the letter guide, the recognizer displays a

lowercase “p.”

Keep characters apart, but keep strokes together. If you draw two characters
too close to each other, the recognizer may identify them as a single character. If
you draw the pen strokes that form a character too far apart, the recognizer may
identify the strokes as two separate characters. For example, in the following
illustration, either set of strokes could be recognized as a “k” or “lc.”

e Ik
k lc

Print distinct letters and numbers. See the illustrations in the appendix,
“Improving Handwriting Recognition,” for tips on printing individual characters.

If you’re left-handed, change the Writing Hand option in the Handwriting
application of the Control Panel. For more information, see Chapter 8,
“Customizing Microsoft Windows.”
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Writing in an Application

You can print directly in most Windows applications. When you print in a writing
area, the pen pointer turns into a pen shape and leaves “electronic ink”—lines that
appear on the screen as you’re printing. If you are not sure whether you can use the
pen in an application, try printing in it. You can print wherever you see the pen-
shaped pointer.

Address List

File
Name:
lJIOIhlnI |S|m|’|f|h| | 1 ] 1 |
Address: In most Windows appli-
cations, the pointer turns
__________________________ into a pen shape and the

pen draws electronic ink.

To use the pen with applications that do not support the pen, you use the Pen Palette
writing window. Once you print, your translated handwriting is sent to the
application. For more information, see “Using the Pen Palette,” later in this chapter.

How Does Handwriting Recognition Work?

When you print in an application, your handwriting is compared to sample characters
and symbols in the recognizer. After you lift the pen and pause for a moment, your
printed handwriting is translated into text and placed at the insertion point. The
insertion point is usually marked with a flashing bar or an underline.

Address List

|J|Olh[nl |Slmlil1-lhl 1 1 1 1 |

Insertion point

Address: \ In most Windows appli-
Address List cations, you can print
File \\ L I directly in the application.
\J
Name:
IJ|0|h1n( |S|m|l|t|h|_1A| 1 1 |
Address: E After you lift the pen, your
handwriting is recognized
___________________________ and the text is placed at

the insertion point.
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Writing in a Text Box

Most dialog boxes require that you enter information. You can print directly in text
boxes in the dialog boxes of most Windows applications. For example, the Search
dialog box in Help provides a text box for entering the word or phrase you want to
find.

To print in a text box you must start each character within the boundaries of the box,
but characters do not have to stay completely in the box.

To enter text in a text box, print
mostly inside the text box.

Type a word, or s
Then choose Sh

Text box

Guide to Pen Computing

Tip To improve handwriting recognition in text boxes, use the Edit Text dialog box.
You may find the increased space and the letter guides make it easier to print in
narrow fields and text boxes. For more information, see “Using the Edit Text Dialog
Box,” later in this chapter.

1. Draw the Edit Text gesture
(a checkmark) in the text box.

Type a word, or select one from the list.

Then chpose Show Topics. 2. Print in the Edit Text
dialog box, and then

tap OK.

handwriting
help

1 OK

llllllllllllgl‘[—He'p_—l
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Correcting Text

There are two ways to correct writing errors in an application:
m Select and replace the text you want to correct

m  Use the Edit Text dialog box to correct the text

Selecting and Replacing Text

If you select text and then print new text, the new text replaces the selected text. Use
this method when you have only a few individual characters to correct.

1. To select the text you want
to replace, press and hold

""" Y A the pen tip at the beginning
Tele: L 0y of the text and then drag
T the highlight over the text
3 f
Direetions: |1/ Take a - h ‘ f you want to select.
Selected text
r \ 2. Print the text you want to
replace it with.

Directions: |1 Take a right| The text is recognized and
replaces the selection.
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Using the Edit Text Dialog Box

When you have more than a few characters to correct, or if you are having difficulty
correcting a particular character, draw the Edit Text gesture (a checkmark). When
you draw the Edit Text gesture through a word, the word is displayed in the Edit
Text dialog box with letter guides.

To correct more than one word at a time, select the words and then draw the Edit
Text gesture through the selection. For more information, see Chapter 3, “Using

Gestures.”
File
Name:
lAdr]jresjs- S '/ e 1. To select the words
) "Office supplies,” press
and hold the pen tip at
. the beginning of the text
Hotes; . and then drag the
Office supplles highlight over the text
you want to select.
____________________________________________________ 2. To display the Edit
Notes: Text dialog box,
draw a checkmark
Office sup\#Bs through the selected
Selected text / words.
Edit Text gesture
D oK |
A Cancel l
L€, 8, 1 1 1 | (O (| |
,
T T T N N | o o o g 3 'Ti

The words are placed in
the Edit Text dialog box.
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Edit Text dialog box —

Wiriting over Errors

You can correct errors in the Edit Text dialog box by printing over them. When the
printed text is recognized, it replaces the incorrect text.

/i To replace text in the Edit
Text dialog box, print over it.

Edit Text

Smi th

4 OK |
I

| cancel |

E 1+ OK
|Jlalnlel |S|m|l|t|h| L—_——J
Cancel ’
I N TN AN NN NN NN SN N SN |
Y S T N T A S N SN NN MO N | 3 ’m

Clearing the Dialog Box

To clear or erase all text in the Edit Text dialog box, tap the Clear button.

DH— To erase all text in
the Edit Text dialog
box, tap Clear.

Using Gestures in the Edit Text Dialog Box

Use gestures to edit the text in the Edit Text dialog box. All gestures work the same
way wherever you draw them—in a box with letter guides, in an application, or in
the Pen Palette writing window. For more information, see Chapter 3, “Using
Gestures.”

For information on: Correcting text

See Help file: Pen Palette Help

Topic: Writing and Correcting Text
Editing Text

Search for: Correct
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Using the Pen Palette

The Pen Palette is a floating palette of writing tools that is available whenever you
start Windows for Pen Computing. The Pen Palette is especially useful for writing in
applications that do not support direct pen input.

Edit menu
Writing window
On-screen keyboard

Tool bar

Writing cells

1

Trainer Help
oK
Clear

Pen Palette tool What it does

Edit menu Displays commands for editing text and
customizing the Pen Palette

Writing window button Opens and closes the writing window

On-Screen Keyboard button Opens the on-screen keyboard

Trainer button Displays a tool for improving handwriting
recognition

Clear button Erases all text in the writing window

OK button Sends recognized text from the writing window
to the active application

Help button Displays online Help commands

Scroll bar Displays more text, if there is any
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Cell

Restoring the Pen Palette

When you start Windows for Pen Computing, the Pen Palette icon is displayed at the
bottom of the screen. To use the Pen Palette tools, you must restore the Pen Palette.

@ To restore the Pen Palette,
| double-tap the icon or label.
e

Pen Palett

Working with the Writing Window

You do not need to use the Pen Palette writing window to write in most Windows
applications; you can write directly in them. However, to write in applications that
do not accept handwriting directly, you must use the Pen Palette.

Printing in the Writing Window

When you print in the writing window, Windows recognizes the letters and numbers
and translates them into text. The translated text stays in the writing window until
you send it to another location.

To enter text in the writing window,
print one letter to a cell. Leave blank
cells for spaces.

— Printed textis
recognized after
you lift the pen and
pause briefly.
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Sending Text from the Writing Window

You can send recognized text from the writing window to an application, a dialog
box, a form, or any place you can enter text. When you send text from the writing
window, it’s placed at the insertion point in the active application. The insertion
point is marked by a blinking bar or an underline.

To move the insertion point, tap the pen where you want to place the insertion point.

= Sample Form

File
Name:
|J10Ihlnl 1S[m|i|t|h| L1 1 |
Addre

1. To place the insertion
point, tap the location
Note/s: where you want to

Insertion point l place the text.

2. Print the text in the
writing window. To
send text, tap the OK
button.

Pen Palette
For information on: Writing in the writing window
Eeip See Help file: Pen Palette Help
Topic: Writing and Correcting Text
Using the Writing Window
Search for: Write
Guide to Pen Computing
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Correcting Text in the Writing Window

You can preview text in the writing window and correct any errors before sending
the text to the active application.

The following explains how to write over incorrect text and use the Clear button to
correct text in the writing window; however, as you’ve already learned, you can also
correct text in the writing window just as you correct text in the Edit Text dialog box
(see “Correcting Text,” earlier in this chapter).

Wiriting over Errors

If the text you print is incorrectly recognized, Windows displays incorrect text or a
question mark. You can correct these errors by writing over them in the letter guides
in the writing window.

To correct text in the letter
guides, write over it.

The corrected text is
displayed after you
lift the pen and
pause briefly.
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Clearing the Writing Window

Occasionally, you may want to erase all the recognized text in the writing window
and start with a “clean slate.” To do so, tap the Clear button.

To clear all text, tap
the Clear button.

The Pen Palette writing
window is cleared of all text.

" For information on:

o

Egé& See Help file:

Topic:

" Search for:

Guide to Pen Computing

Pen basics
Pen Palette Help

Pen Basics
Pen Palette Tools

Tool bar
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Using the On-Screen Keyboard

You may sometimes find it easier to enter text—particularly numbers—with the on-
screen keyboard. To open the on-screen keyboard, tap its button in the Pen Palette
tool bar or double-tap the On-Screen Keyboard icon in the Microsoft Pen Tools

group window.

. 1. To open the on-screen keyboard,
tap the On-Screen Keyboard button.

Pen Palette

Restore

] F5 IF6 IFI‘ IFSI F3 IF(OIFH IF(2] PS(ISLkIP:cI

Move

On-screen
keyboard

Minimize,

| [

> fHm §Pq

Options//.

ose A 4

t oy fu B
afih §i Bk

skt B Bk fc §v fb fn fm §.

o fp fl |

4

[ Enter

7 [oshir

EndfPg

Ent. |

Eal

lAIx I

Ctrl

.)l Inz

Control menu.

To “type” this

2. To close the on-screen keyboard,
choose Close from the keyboard's

Tap this

Numbers, lowercase letters,
function keys, direction keys

A single uppercase letter
A series of uppercase letters
A key combination

Keys on the numeric keypad

The key you want to “type”

Shift + the letter

Caps Lock

Alt or Ctrl, and then the letter(s)

Tap NLk to turn Num Lock on and off
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For information on: The on-screen keyboard
Help See Help file: Pen Palette Help
Topic: Writing and Correcting Text

Using the On-Screen Keyboard
Search for keyword: Keys

Minimizing and Closing the Pen Palette

To make it easy to use the Pen Palette tools, keep the Pen Palette open. If you want
to keep the Pen Palette temporarily out of your way, minimize it.

Minimizing the Pen Palette

The illustration shows how to minimize the Pen Palette and shrink it to an icon at the
bottom of your screen.

A To minimize the Pen
Palette, tap here.

Pen Palette

Pen Palette icon @

Pen Palette

Guide to Pen Computing
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Closing the Pen Palette

To close the Pen Palette, you can double-tap the Control menu box or choose the
Close command from the Control menu. When you see a message that informs you
that you are closing the Pen Palette, tap Yes to close.

To close the Pen Palette, double
tap the Control menu box...

Restore K JoK]

Move
Size | ] 1 1 1 1 ]
Minimize

... or choose Close
from the Control menu.

If you close the Pen Palette, you can open it again by double-tapping its icon in the
Program Manager Pen Tools group.

Guide to Pen Computing
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Using Gestures

This chapter shows you how to use the predefined gestures and how to define your
own gestures.

What Is a Gesture?

A gesture is a special symbol you draw to tell Windows for Pen Computing to carry
out an action. By now you have probably practiced, for example, drawing a
checkmark through a word to tell Windows to place the word in the Edit Text dialog
box where you can correct it.

fOK]
Canoel]
e N e

How Do Gestures Work?

Like printed characters, gestures are identified by the handwriting recognizer and
translated; unlike printed characters, gestures are translated into actions, rather than
text. But you can draw gestures anywhere you can print.

Each gesture (except for the Undo gesture) carries out its action where you draw it.
For example, when you draw the Delete gesture over a character, the character is
deleted; when you draw the Delete gesture over selected text, the selected text is
deleted. You can draw the Undo gesture anywhere you can write and it carries out its
action—it cancels or reverses the effect of the previous action.

For the recognizer to identify a gesture, you must draw it as a separate symbol—not
in combination with a letter or number. Once you have drawn the gesture, lift the
pen and pause while the gesture is being recognized. After the gesture is recognized,
you can draw another gesture or print more text.

Guide to Pen Computing
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Help on Gestures

All Windows for Pen Computing Help topics include a special button that
automatically displays the Gestures topic. The Gestures button is available from the
button bar of any Windows Help file. It provides a quick demonstration of how to
draw predefined gestures.

Pen Palette Help
File Edit Bookmark Help

The Gestures button
is available from all
Windows Help files.

" For information on: Gestures
See Help file: Any Windows Help file
Topic: Gestures button
Search for: Gestures

The Learning Pen Basics Tutorial

The Learning Pen Basics online tutorial demonstrates the predefined gestures. You
can also use this tutorial to practice printing characters.

To use the Learning Pen Basics tutorial, start it and then follow the instructions on
your screen.

There are three ways to start the Learning Pen Basics tutorial:

m  Double-tap the Learning Pen Basics icon in the Microsoft Pen Tools group
window.

Learning Pen Basics



®  From the Program Manager Help menu, choose Windows Tutorial.

a danage Vi A

File  Options  Window elp

Contents
Search for Help on...

How to Use Help
Windows Tutorial

About Program Manager...
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= From any Windows Help file, choose the Gestures or Pen Basics button. At the

bottom of the screen, tap the Demo button.

File Edit Bookmark Help

= Pen Palette Help [ v]a]

_(_Eontentsl Search l Back I History L_gestures IEen Basics

Pen Basics

The topics listed below offer introductory information about basic 1+
skills with the pen.

To view a help topic, tap one of the underlined topic names below.

Using the Pen
With the Pen
ng and Moving Obiects Using the Pen
Using ures
Using the Pen Paleite
Moving and Sizing the Pen Palette
Training Windows to Reorganize Your Printing

To see a demonstration of how gestures are drawn, and to have a
chance to practice drawing gestures, tap the button below.
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Using Predefined Gestures

AN

Guide to Pen Computing

The following pages introduce the twelve gestures supplied with Windows for Pen
Computing. The gestures are divided into two groups:

m Six gestures for basic editing tasks

m  Six additional gestures that are very useful for editing and command shortcuts

Basic Editing Gestures

The basic editing gestures are Edit Text, Backspace, Insert Space, Insert New Line,
Cut, and Undo.

Edit Text

The Edit Text gesture copies a single word or selected text into the Edit Text dialog
box. To edit a single word, draw a checkmark through the word. To edit multiple
words, select the words, and then draw a checkmark through the highlighted
selection.

Drawing Tip

Draw the checkmark in one continuous stroke. Draw the second, upward part of the
stroke considerably longer than the downward segment. Make a sharp point; do not
curve the tip.

1+ OK !
Cancel ’
¥ e ]




Chapter 3 Using Gestures 53

7

]

Backspace

The Backspace gesture erases the character you draw the gesture through.

Drawing Tip

Draw a single, overlapping line at a 45-degree angle, up and to the left and then
down and to the right. Draw the gesture through the character you want to erase.

N\
The sampl§jtext

The sampl text

Insert Space

The Insert Space gesture adds a space where you draw the gesture.

Drawing Tip

Draw one continuous line down and then to the right. To avoid confusion with the
letter “L,” draw the right segment of the stroke considerably longer than the
downward segment. Make a sharp turn in the line; do not draw a loop or curve
between the two segments of the gesture.

The samplqte
e

The sample text
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===

¥

Insert New Line

The Insert New Line gesture adds a new line. Text that follows the gesture is moved
down to the new line. In the Pen Palette writing window (with letter guides on), an
arrow will appear, indicating that a new line will be inserted into the active
application when you tap OK.

Drawing Tip

Draw one continuous stroke, down and then to the left. To avoid confusion with the
letter “J,” draw the left segment of the stroke considerably longer than the downward
segment. Make a sharp turn in the line; do not draw a loop or curve between the two
segments of the gesture.

The sanjplejtext
-

The sample
text

Cut

The Cut gesture removes text or objects from their current location and places them
onto the Clipboard. To move information, you cut it from its current location and
then paste it in at the new location.

To cut multiple words or objects, select the words or objects, and then draw the Cut
gesture over any part of the selection.

Theﬁ text

The text
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Drawing Tip

From the bottom up, draw a “pigtail.” Keep the loop small.

Undo

The Undo gesture reverses or cancels the previous action. For example, if you delete
text and then immediately draw the Undo gesture, the deleted text is “undeleted” and
returned to its previous location. You can draw the Undo gesture anywhere you can
write; you do not have to draw the Undo gesture over the results of the previous
action.

Drawing Tip

Draw the “diving fish” shape downward from left to right with a large loop at the
bottom. To avoid confusion with the letter “0,” make the “body” long.

/
I
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O

P
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Additional Gestures

The following describes the six additional gestures.

Copy

The Copy gesture duplicates selected text and places it onto the Clipboard. To place
a copy in another location or in another application, move to the location where you
want to put the information, and then draw the Paste gesture.

To copy multiple words or objects, select the words or objects, and then draw the
Copy gesture over any part of the selection.

Drawing Tip

Draw the fish shape down from right to left and back. Keep the gesture horizontal.

My
ThelEwulls text

Paste

The Paste gesture places the Clipboard’s contents at the tip of the gesture. If text is
selected, the contents of the Clipboard replace that entire selection. You can paste
the Clipboard’s contents wherever you draw the Paste gesture.

Drawing Tip

Draw an arrowhead, working from left to right, with the tip pointing to where you
want to place the Clipboard’s contents. Draw a sharp point (not a curve or
semicircle) for the tip of the gesture. Draw the left and right segments approximately
the same size.

The to/xt
A

The sample text
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\

Delete

The Delete gesture erases a single character or a selection. To delete a selection,
draw the Delete gesture through the selected text.

Drawing Tip

Draw the line at a 45-degree angle, up and to the right and then down and to the left,
through the character or selection you want to delete.

The text

Delete Word

The Delete Word gesture erases the word(s) that you draw the line through.

Drawing Tip

Draw a single, overlapping horizontal line to the right and then back to the left
through any part of the word or words you want to delete. Do not lift the pen
between the right and left motions. You do not have to cover each character in each
word you want to delete. To delete part of a word, use the Delete gesture.

The text
(—

The text
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' w Extend Selection

The Extend Selection gesture enlarges a selection to include all text and spaces
between what you have already selected and the point where you draw the gesture.
Lines, sentences, or paragraphs can be part of the extended selection.

Drawing Tip

Draw a single, overlapping, vertical line. Draw the first part of the line down and the
second part up. Keep the line vertical. Do not lift the pen between the down and up
motions.

The R e
The

Insert Tab

The Insert Tab gesture inserts a tab.

]

Drawing Tip

Draw one continuous stroke, up and then to the right. Make the right segment of the
stroke considerably longer than the upward segment. Make a sharp turn in the line;
do not draw a loop or curve between the two segments of the gesture.

/

>
The sampleftext

The sample  text
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Defining Your Own Gestures

With Gesture Manager, you can create an additional set of gestures to perform
actions you define. These additional gestures are useful for carrying out commands
you frequently use or for text you often write. For example, you can define a gesture
that carries out the File Save command and you can define another gesture that prints
your name.

The symbols you use for creating your own gestures consist of any letter of the
alphabet enclosed in a circle.

Predefined Circled-Letter Gestures

The keystrokes for the following three circled-letter gestures are predefined, but you
can change them at any time. You can see the keystrokes assigned to these symbols
by choosing the Gesture Manager command.

Gesture What it does

Circled-C Types the Ctrl+Ins key combination. In most Windows
applications, carries out the Edit Copy command.

Circled-P Types the Shift+Ins key combination. In most Windows
applications, carries out the Edit Paste command.

Circled-U Types the Alt+Backspace combination. In most Windows
applications, carries out the Edit Cut command. \

Note Keystrokes you assign to a circled-letter gesture may carry out different
commands in different applications. For example, the predefined Circled-C gesture
carries out the Edit Cut command in Microsoft Write for Windows and Microsoft
Word for Windows; however, other applications may reserve the Ctrl+Insert
combination for another action or command.
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Edit menu

Pen Palette

Guide to Pen Computing

To display the Gesture Manager, choose
Gesture Manager from the Edit menu.

— B = [EA][ x]K

Undo
Cut

Copy Gestures For: JGUFN Tl [EHT1E E

Paste A Gestures:

Options...
Gesture Marfager...

Gesture Manager

The Circled-C gesture {Ctrl}{Ins}
enters the keystrokes Ctrl
(Control) and Ins (Insert).

Creating a Gesture

To create a gesture, you assign keystrokes and text to one of the 26 circled-letter
symbols in the Gesture Manager. You can define a single action for each circled-
letter symbol or you can make each symbol carry out a different action for each
application on your system. For example, you can define the Circled-S gesture to
carry out the File Save command for every application, or you can define it to carry
out the File Save command in one application and the Edit Styles command in
another application.

To use keys to define a gesture, use the on-screen keyboard and tap the keys you
want. To add text, print in the letter guides or use the on-screen keyboard. To correct
keystroke errors, tap the Clear button and then start over by tapping the correct keys
on the on-screen keyboard. To correct text, print over individual characters in the
letter guides or tap the Clear button to erase all text.
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1. To define the Circled-A
gesture for all applications,
tap the Edit button.

Gestures For: | All Applications

Gestures:
v — 2. To "type" the keys you
want to use for the
gesture, tap the
On-Screen Keyboard icon.

= d e e

Gesture: @

Defined For: All Applications

OK 11 3. To remove the

on-screen
m keyboard and
m close the Edit

Gesture

Restore ﬂ display box,
tap OK.
| Help §

SOCPE

Write Gesture Mapping Here:

T+

=
F1 Ira 'rs In I F5 Irs Irr Irsl Fa Irmlru Iml ps:lsmlml
l‘l Iz Iz I+ I5 ls I? B lg ol I- lq—Back; oz [om [P | [nodl?

Cel ffEndfiPa | [tm f + o [+

+ -+
= Endll 4 JPg JEnt
“0. ..l In Del

~ For information on: Defining your own gestures
1| See Help file: Pen Palette Help
: Topic: Using Gestures

Defining Your Own Gestures

Search for: Define
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Training the Recognizer

When you print in the writing area, the recognizer compares your handwritten
characters with the sample characters in the recognition database. When the
recognizer matches your characters with the samples in the database, it translates the
samples into recognized text and displays the text in the writing area.

If you print a character that does not closely match a sample character in the
recognition database, the recognizer translates the text incorrectly or displays a
question mark.

To improve recognition, you can train the recognizer by adding samples of your
printing to the recognition database. For example, you can add a sample for your
uppercase “F” to the database. The next time you print an uppercase “F,” the
recognizer will translate it correctly.

There are two ways to train the computer to improve recognition:

®  Train the recognizer. Use this method while you work by choosing the Trainer
button from the Pen Palette tool bar or choosing the Trainer icon from the pen
tools group.

m  Customize the recognition database. With this method, you fine-tune the
recognizer by viewing and modifying the shapes it contains. The instructions for
customizing the recognizer are available in online Help only.

Note This chapter explains how to use the Microsoft trainer. If you are using
another recognition system, see the documentation for that system.

Using the Trainer

If you frequently see question marks instead of the characters you printed, or if you
notice certain characters are consistently incorrectly recognized, you’ll probably
want to train the recognizer.

You don’t have to set up a formal training session to train the recognizer. You can do
it while you work, because the trainer (which instructs the recognizer) is always |
available from the Program Manager Pen Tools group or from the Pen Palette tool |
bar.

The trainer continuously tracks the electronic ink from your handwriting and the
translated text from the recognizer. When you choose the Train button from the Pen
Palette tool bar, the Train dialog box displays the translated text above the
handwriting that was most recently recognized. For example, when you print your
name and it’s recognized, both the handwritten and recognized versions of the
characters are displayed in the Train dialog box.
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Training: Single Characters

Most recognition problems occur when the recognizer incorrectly translates a single
character. Here’s the procedure for getting single characters recognized.

Pen Palette tool bar

Guide to Pen Computing

2=

1. After printing the characters you want

to train, tap the Trainer button.

<4

=

5 [x]d [2]

4

Hig/ilight the ink to train by selecting the

mi/jrecognized text in the boxes below.

0io!

J Eﬂ Train...

V\OO

Advanced...

Train Ink

"\

Train this ink: A+

n e
@ Character

O Text

QO Gesture

) || e

Warning

2. Tap the character
you want to train...

3. ...and then tap the
Train button. The Train
Ink dialog box appears.

4. Print the character, or
tap the on-screen
keyboard icon to "type"
the character you want
to train.

5. Tap OK. When you see a message
asking you to confirm the training,
tap the Yes button.

If you train the recognizer with ink that is currently recognized as another character
or gesture, the recognizer displays a message informing you that the shape is
currently recognized as something else. For example, the recognizer displays the
following message if you try to train it to recognize “U” as the Undo gesture.

u

This shape is currently recognized as:

Choose OK to recognize it only as:

Undo

|70K i rCancell Help l




Chapter4 Training the Recognizer 65

If you see this message and tap OK, every time you print an uppercase “U,” the
recognizer will carry out the Undo gesture. For this example, you would choose
Cancel. Any time you are not certain about the training, choose Cancel.

Training: Multiple Characters

Occasionally, a single printed character is recognized as two separate characters.
This usually happens when you separate the strokes that make up a character. For
example, in the following illustration, the “k™ in “dock™ has been recognized as two
separate characters—“1” and “L.”

If you consistently print single characters that are recognized as multiple characters,
you can train the recognizer to identify the separate characters as a single character.
To do so, you select the misunderstood characters, and train the recognizer just as
you would with a single character.

1. To train the recognizer to recognize the characters
as one, drag the pen tip over both characters.

4 Trainer
Highlight the ink ¥/f train by selecting the
misrecognized te/(t in the boxes below.
|d o ch ;L l EE IE 2. To train the recognizer,
Lo : tap the Train button.
d 0cC I(. The Train Ink dialog box
appears.
Advanced...ﬂ
Train Ink
T 3. Print the character, or
Train this ink: As*:—@[? tap the on-screen
k keyboard icon to "type"
' @ Character the character you want
O Text recognized.
O Gesture
4. Tap OK.
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Training: Gestures

If you consistently have problems drawing a gesture, you can train the recognizer to
identify your variation of the gesture. For example, if you consistently draw the Edit
Text gesture (a checkmark) with an extra hook on the end, you can train the
recognizer to identify your hooked mark as the Edit Text gesture.

Make certain when you train the recognizer regarding gestures that you do not
replace gestures with characters that you use often. For example, you should not
train the recognizer to identify an uppercase “T” for the Tab gesture (you would
have problems every time you print an uppercase “T”).

Customizing the Recognition Database

To customize the recognition database and browse through the shapes and symbols it
contains, you use the Advanced button in the Train dialog box. If you do not see the
Advanced button in the Train dialog box, you are not using the Microsoft Alpha-
numeric Recognition System.

Note Use caution when browsing and modifying any recognition database--you can
easily erase or modify the shapes and symbols it contains and reduce, rather than
improve, recognition.

You can use more than one recognizer with Windows for Pen Computing, each
recognizer containing a different database of shapes and symbols. The methods you
use to customize various recognition databases may differ. See online Help for
information about customizing your database. The Pen Computing system detects
which recognizer you’re using and provides the appropriate information.

To get Help on customizing the shapes in the recognition database, tap the Advanced
button in the Trainer dialog box, and then tap the Help button in the Shape Viewer
dialog box.
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Getting Help

Because you often use Windows for Pen Computing away from your desk, most of
the documentation for it is in online Help. This chapter contains the following
sections:

m  How Windows Help Is Organized
= Using Help Notes

m  Using Help Contents

®  Using Help Buttons

m  Searching for Help Topics

m  Exiting Help

Some of the screens and information you find here will be familiar, since this
chapter is an expansion of information introduced in Chapter 1.

How Windows Help Is Organized

Each Windows application has its own unique Help file. For example, the Pen
Palette has its own Help file, Program Manager has its own Help file, and Microsoft ‘
Write has its own Help file. To get Help about a task for a given application, start or

restore that application and then choose the Help command.

The following table lists the Windows Help files and the Help information each

contains.
Help file What it covers
Pen Palette Help Pen Palette tools, writing and correcting text,
using gestures, training the recognizer
Program Manager Help Windows basic skills, using commands and
dialog boxes, starting and working with
applications, working with group windows
File Manager Help Working with files and directories, saving files,
working with hard and floppy disks, managing
documents |
Control Panel Help Customizing windows |
Print Manager Help Print Manager, which installs and sets up your
printer, prints your files, and can connect you to |
networks
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Using Help Notes

To make it easier to find related task information in online Help, this guide contains
Help notes that direct you to specific online Help topics. You may already have used
some of these notes. As a reminder, the following example explains a Help note and
shows you how to find the related online Help topic.

" For information on: The on-screen keyboard
See Help file: Pen Palette Help
Topic: Writing and Correcting Text

Using the On-Screen Keyboard

o S

Search for: Keys

This example shows:
m There is more information about the on-screen keyboard in online Help.
® The information is in the Pen Palette Help file.

You must be using the Pen Palette to find information in Pen Palette Help. The
same is true for any other Help file—you must be using the application that the
Help file is attached to before you can use its Help.

= The Help topic “Using the On-Screen Keyboard™ is located in the Pen Palette
Help Contents screen under the heading “Writing and Correcting Text.”

®  You can also find the “On-Screen Keyboard” topic by using the Search command
and the keyword “keys.”

Using Help Contents

The Help Contents screen lists the major Help topics, grouped according to task. To
display Pen Palette Contents, you choose the Help button on the Pen Palette tool bar.

| 1. To get Pen Palette Help,
tap the Help button.

/)
Ed
onte H— 2. To view Help Contents,
L 4 1 1 1 1 |seachforHelpon.. | [ tap Contents.

How to Use Help...

| TR B B About Pen Palette... ||
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To display Help Contents for other applications, such as Program Manager or File
Manager, choose the Help menu from the application menu bar.

The Help menu is also
available from the menu bar.

Contents
Search for Help on...

Notebook Pen Palette  Learnin
Pen Bas| How to Use Help

<§“_‘=? ﬁ Windows Tutorial

On-screen Trainer About Program Manager...
Keyboard

Scrolling Through Help

To see more topics or read more Help text, you can scroll through the Help window.

= Pen Palette Help v Al
File Edit Bookmark Help
Contents i Search I Back l History I Gestures IEen Basics

Pen Palette Help Contents

Pen Palette Help

To view a help topic, tap one of the underlined topic names below.

To see more topics below, use the scroll bar.
Basic Skills

Help Basics |
What is the Pen Palette?
How to Use the Pen

Moving and Sizing the Pen Palette

Writing and Correcting Text

Using the Writing Window — To scroll a lot, tap

Editing Text . the scroll bar.

Reversing the Previous Action

Moving and Copying Text + 1— Toscroll a little, tap *?

the scroll button. f
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Viewing Help Topics
Help topics are underlined in the Help Contents. To read a Help topic, tap the
underlined topic title.

= Pen Palette Help [v]a
File Edit Bookmark Help
Contents I Search l Back I History I Gestures |;Pen Basics

Pen Palette Help Contents

Pen Palette Help

To view a help topic, tap one of the underlined topic names below.

— To view a topic,
tap it.

Basic Skills
Help Basics
What is the Pen Palette’
How to Use the Pen

Moving and Sizing the Pen Palette

Topics
Writing and Correcting Text
Using the Writing Window

Editing Text
Reversing the Previous Action
Moving and Copying Text
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Pen Palette Help ———

Definition box

Viewing Definitions

Most Help topics contain definitions that display more information about a term or
important concept. Words that have definitions are indicated with dotted underlines.
When you tap a word to get its definition, a window pops up and stays open until
you tap again.

= Pen Palette Help [ v[a
File Edit Bookmark, Help
(_)ontemsl Search I Back l History ' Gestures !Een Basics

Pen Palette Hely/ Contents

To view a help topic, tag one of the underlined topic names below.

Tap
— - — To close a definition
To press the pen tip against the screen and lift the pen tip up. box, tap it.

TEIp Basits

What is the Pen Palette?

How to Use the Pen

Moving and Sizing the Pen Palette

Writing and Correcting Text
Using the Writing Window
Editing Text

Reversing the Previous Action
Moving and Copying Text
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Using Help Buttons

All Help topic windows contain Help buttons. To use the Help buttons, tap them.
Different applications usually contain different buttons; however, all the Help files
that come with Microsoft Windows have the same six buttons shown here.

= Pen Palette Help [v]a]
File Edit Bookmark Help
Pen Palette ——— || Contents I §earchJ Back 1 History ] Gestures lEen Basics
Help buttons e -
Pt The Pen Palette
________________________________________________________ Y
Help button What it does
Contents Displays the Help Contents screen
Search Displays the Search dialog box, which you use to find
Help topics
Back Displays the Help topic you previously viewed
History Displays a list that tracks the Help topics you have
viewed; to return to a Help topic, tap it
Gestures Displays and explains the predefined gestures
Pen Basics Displays Help topics covering use of the pen, selecting

objects, using gestures, and so on
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Searching for Help Topics

You can find Help topics by searching for keywords in the Search dialog box. For
example, you can find the Help topics that discuss gestures by searching for the
“gestures” keyword.

The following procedure shows you how to use the Search button from the Help
window. You can also choose the Search command from the Help menu.

1. To display the Search dialog
box, tap the Search button.

Pen Palette Help ——"rie  Edit  Bfpkmark _Help
_Qrontents ] Sedirch ] Back l History I Gestures ﬂEen Basics
Pen Pa '

---------- 2. To scroll to the
gestures key-
word, printa
“g” here.

gesture mapping - 3.To display related
) gestures topics, tap Show
Search dialog box go back Tapies
handwriting :

Select a topic, then choose fjjo To.
/ e

Using Predefined Gesturéé

4. To view a topic, double-tap it or tap
the topic and then choose Go To.
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Help on Help

There are more Help features than those covered in this chapter. For example, you
can annotate a Help topic and add comments to it, and you can use bookmarks to
mark topics that you use frequently. For complete information about Help, use the
How To Use Help command.

1. For complete Help
instructions, choose Help.

v

Contents ; ‘f '

| 1 | 1 | | Search for Help on ...
ow to Use Help 2. Choose this command.

| | \ | | | | About Pen Paletie ...
{

Exiting Help

Pen Palette Help

When you leave Help, you return to whatever you were doing before you got Help.

— Pe Paletie elp Vi A
W Edi Bookmark Help
Open ... ch I Back | History l gimuresjgﬂBasics
Print To|
Print Sejup ... ette
_________________________________________ [ ol

To exit Pen Palette Help,
choose Exit from the File menu.
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Microsoft Windows Basic Skills

This chapter covers the basic skills for using Windows with the pen. In Chapter 1,
you practiced many of these skills; however, unless you are an experienced Windows
user, you will want to read this chapter to learn more about Windows.

Using the Windows environment with a pen is very much like using Windows with a
mouse. With a mouse, you point and click. With the pen, you tap.

This chapter covers the following topics:
m  Using Program Manager

m  Starting Applications

®  Working with Windows

m  Choosing Menus and Commands

m  Using Dialog Boxes

m  Saving Documents and Files

m  Exiting an Application
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Using Program Manager

Program Manager

With Microsoft Windows, you work with applications (programs that you use for a
particular kind of work, such as word processing or inventory management) and
icons (graphical representations of the applications) that are displayed in areas of the
computer screen called windows.

When you start Microsoft Windows, the first thing you see is the Program Manager
window. Program Manager provides methods for arranging and working with
application icons in group windows. A group window is a Program Manager window
that contains related application icons. For more information on group windows, see
“Creating a Group Window” in Chapter 7, “Managing Microsoft Windows.”

= Program Manager via
a

File Options Window Help

Microsoft Pen
Tools group

= Microsoft Pen Tools (v~

Icons

Pen Palette icon —@
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en Palette Learning Sample Form
Pen Basics

£

On-Screen Trainer
Keyboard
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Starting Applications

Before you can work with an application, you must start it. The easiest way to start
an application is from within Program Manager.

To start an application from Program Manager, you may first have to open the group
window that contains the application icon. For example, the Microsoft Write
application is located in the Accessories group window. To start Microsoft Write,
you first open the Accessories group window and then double-tap the Write icon.

2. To start an application,
double-tap its icon.

For information on:
See Help file:
Topic:

Search for keyword:

Paintbrush ~ Terminal

Clock

Calculator PIF Editor

1. To open a group window,
select its name from the
Window menu.
— Proqra o wia
File Options o[l Help
Cascade Shift+Fp
Tile Shift+Ff
Arrange Icons
1 StartUp
R 2 Games
3 Pen SDK
GGG 4 Accessories
Main S Main
STele) Accessories
[l B e
Accessories Games

Notepad

Starting applications
Program Manager Help

How To...
Start an Application

Start
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Working with Windows

All your work and all the tools you use to manage your work are displayed in
windows. The following illustration shows the elements common to most application

windows:
Minimize
I Control menu Title bar Menu bar Maximize
== . ad via
File Edit Search Character Paragraph Document Help
| e Insertion
point
— Vertical
Workspace scroll bar
¥
l Horizontal scroll bar Window border
Window element What it does
Control menu Displays commands for moving and sizing the

active window (the window you’re using).

Title bar Displays the name of the application and the
document. When you drag the title bar, the
window follows.

Menu bar Contains menus, which each display a list of
commands. To choose menus and commands, tap
them.

Minimize and Maximize Shrink or enlarge the active window.

buttons

Insertion point Indicates where printed text will be positioned in

a document. To move the insertion point, tap the
location where you want to place it.

Scroll bars Display more of a document or list. Tap the
arrows to scroll a little; tap the space before or
after the box to scroll a lot.
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Window element What it does
Window border Moves when dragged so that the window shrinks
Or grows.
Workspace Displays what you’re working on.

Moving Between Windows

One of the advantages of Microsoft Windows is that you can open multiple windows
and work with different applications at the same time. This is especially useful when
you want to copy or move text between applications. There are three ways to move
between open windows and applications:

®  Minimize and restore windows
m  Activate a window by tapping it

®  Choose an application window from the Task list

Minimizing and Restoring Windows

The most common way to move between open windows is to minimize the window
you are currently using (the active window) and restore the icon for the window you
want to use next.

When you minimize a window, its icon appears at the bottom of the screen. When
you restore a window, it resumes its previous size.
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To minimize Write, tap
the Minimize button.

Paintbrush - RIBBONS.BMP v[a

dit View Text Size Pick Options Help

o~

AOO[ORLE
Y IIEIETN

hig

LTI
=

Write icon ——————— &Jﬁ To restore Write,

Write double-tap the icon.
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83

Tapping a Window to Activate It

Tap any part of a window to activate it. It then becomes the active window and

appears on top of the other open windows.

=] Paintbrush - RIBBONS.BMP

=i

| File Edit View Text Size Pick Options Help

=

[
| o
(2]

S

2/ Write - [Untitled] [v|a
Olm File Edit Find Character Paragraph Document Help
4
ole] |
Oe
D=
==
==h
[Z==3| I:
¥
Pag <+ =»

To activate a
window, tap it.
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Choosing a Window from the Task List

The Task List displays the name of all open windows. When you can’t see the
window you want to use, choose it from the Task List.

Note You can also double-tap a window name in the Task List to activate the

window.
1. To display the Task
List, double-tap any
open area.
=] Paintbrush - RIBBONS.BMP [v]a
File E

dit View Text Size Pick Options Help

R s
e -
= Write - [Untitled] xla
File Edit Find Character Paragraph Document Help
4
|
= Write - [Untitled]
4
-»

Paintbrus%lBBONs.BMP
2. To activate a window,
Switch@)] [ EndTask | [ cancel | tap its name and then
tap Switch To.
Rascadi] liIile ] [ Arrange Icﬁ 0
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Title bar

Moving and Sizing Windows

When windows overlap, you can activate the window you want to use and move it or
change its size to suit your needs. The following illustration shows you how to move

the Pen Palette; other windows work the same way.

To move the Pen Palette,

drag the title bar. An outline of When the outline is where
the Pen Palette follows the you want the Pen Palette to

be, lift the pen.

pentip. —— )
X /’

Pen Palette

Pen Palette

Pen Palette outline ——

To enlarge or reduce any window, drag a window border, as shown here with the Pen

Palette.

— To enlarge the Pen
Palette, drag a
window border.

\— When the outline is as

large as you want the

window to be, lift the pen.
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Choosing Menus and Commands

Menus list commands, such as Copy or Delete, that represent actions you can carry
out. Menus can also contain names of open windows or formatting characteristics,
such as bold or center.

Tapping to Choose Menus and Commands

To choose commands, you tap the menu where the command you want is listed, and
then tap the command you want to choose. For example, to reverse your previous
editing action in Microsoft Write, you tap the Edit menu and then choose the Undo
Editing command by tapping it.

1. To choose a

menu, tap it. 2. To choose a command, tap it.
= o o wia
File Find Character ragraph Document Help
Trey do Editing 882 6081 LS
FilmW, 0520
12114 Cut Ctrl+X B 8842390
Los Al Copy Ctrl+C

Paste Special... Cirl+V
Novel Paste Link
Doug| Links...
ToT'a| Obiect
Londd Insert Object...
Move Picture
!?eor Size Picture S :

e — e —— ——
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Selecting and Choosing

For most commands, you must first select or highlight the object you want the
command to act on before you choose the menu and command. For example, to
make a word bold in a Microsoft Write document, you must first select the word.

To select a word, press and hold the pen tip at the beginning of the text you want to
select. When you see the blinking bar and selection arrow under the pen tip, drag the
highlight until it covers everything you want to select.

After the text is highlighted, you choose the Character menu, and then choose the
Bold command. You use this “select and choose” method most often when you’re
working with text or managing documents.

ITo modify text, selectit... ...then, choose a menu and a command.

Write - [Untitled] /

7 [IEIEEE) Paragraph |Dffcument Help
/ Regular

File Edit Fi

Italic Ctrl+l

ron Film .

101 Regent Street| Underline Ctrl+U

London W1 Superscript
Subscript

Dear Doug:
Reduce Font

Karl and | reviewe Enlarge Font

I week. Overall, it looks g
be involved with 1

y the start of a long-term
s about.If you want to di

Fonts...
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Using Dialog Boxes

Dialog boxes are forms you use to tell the Windows environment more about what
you want to do. A dialog box may include additional boxes from which you choose
options by entering text, numbers, or other settings, or it may simply display
additional information.

Some options in a dialog box may appear dimmed. This indicates that the option
does not apply in the current situation or that you may need to make a selection
before choosing that option.

The following dialog box contains most of the elements found in Windows dialog

boxes.
List box
= anda Ol
User
lﬁfault User i! .
I — Becognizef---g' Command buttons
Writing Hand Menu Style l* =
- Qlctlonary...j-
[ ~| (2 4_ :
a2 1 ! -
Recognize Option buttons
When Pen is Lifted Scroll bar
L
! Scroll box
Test Area: fe X T J
Check boxes Text box

List boxes display command choices. Some list boxes display all the choices
automatically, and others (drop-down list boxes) display the choices after you tap the
arrow on the right of the list box. To select an option from a list box, tap the scroll
bar to move to the desired choice, and then tap the option you want to choose.

Command buttons carry out actions. For example, the OK button closes the dialog
box and uses the selected options to carry out the command that displayed the dialog :
box. The Cancel button closes the dialog box, ignores any options you may have |
selected, and cancels the command that displayed the dialog box. The ellipses (...)

that follow the Recognizer and Dictionary buttons show you that these command

buttons display other dialog boxes. The Help button provides Help information about

the active dialog box.
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Option buttons represent a group of related options. To select one of the options,
you tap it. When you select an option, a black outline appears around the option. For
some options, the button is round and appears next to the option it represents.

Scroll bars relate to the options nearest them. Scroll bars contain scroll boxes that
slide from left to right (or up and down) to indicate increasing or decreasing size, ‘
speed, or location. For example, the scroll bar to the right of the Recognize options “
regulates the relative amount of time to allow for printing to be recognized. To I
increase the time, tap the right scroll arrow or drag the scroll box to the right. !

Text boxes require you to write in your selection. You can print text in the box or ‘v'
use the on-screen keyboard to enter text in a text box. To improve handwriting I
recognition in a text box, you can draw the Edit Text gesture and use the Edit Text I
dialog box to enter the text. For more information, see Chapter 2, “Writing and |
Correcting Text.”

Check boxes contain options that can be turned on or off. When you turn on a check |‘
box option, an “X” appears in the box. To turn a check box option on or off, tap it.
Check boxes, unlike option buttons, allow you to turn on as many items as you want.

Saving Documents and Files |

A document is something you create with an application, such as a memo, report, |
drawing, inventory management form, and so on. A document is a type of file; files ‘
are what computers use to store information. i\

For most applications, all your work is temporary until you save it. You should save |
your work often (choose Save from the File menu). Doing so helps your applications ‘
perform faster and lessens the chance of losing work if there is a power failure. |

|

Note Some applications, such as the Notebook accessory that comes with Windows |
for Pen Computing, automatically save your work while you work or whenever you ‘
exit the application. For more information on how an application saves information,

open the application and get Help on Saving.
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Exiting an Application

After working with an application, you can put the document and the application
away at the same time by exiting the application. If you choose the File Exit
command from the application before you save your changes, the application
displays a message asking you to save the document.

To exit an application,

double-tap the Control
menu box...

@ Write - [Untitled]
IS Edit Find Character Paragraph Document Help

New
Open...
Save
Save As...

Print...
Print Setup...
Repaginate...

...or choose Exit from the File menu.

For more information on working with applications, start the application you want to
use and choose Help.

Guide to Pen Computing




Customizing Microsoft Windows

Microsoft Windows includes an application called the Control Panel that you can use
to customize various elements of the Windows environment, including pen settings,
handwriting settings, and date and time settings.

This chapter describes the Pen and Handwriting settings in the Control Panel. For
information on the Control Panel settings not covered here, see Control Panel Help.

To open the Control Panel, double-tap this icon.

bw Help

Main

=]
B 2 &

File Manager Control Panel Print Manager

Clipboard

DOS Prompt

Control Panel

V[~

File Options Wind
Program Manager ——|
Settings Help
@ Fonts
Control Panel e
Q &
I Printers Intemational
$
Rotate Calibrate

§
Ports Mouse
; 4 —
B e
Date/Time Network

386 Enhanced  Drivers

Desktop Keyboard
I %y
Pen Handwriting
de

Sound

Customize desktop colors

For a brief description of the function of each Control Panel application, tap each
icon and read the message at the bottom of the Control Panel window.

Some of the Control Panel settings may not apply to your computer and will
probably not be of interest to you. For example, you may not care about the Color
settings if you have a monochrome display, or you might ignore the Keyboard and

Mouse settings if you use a pen system.
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Changing Pen Settings

You can use the Control Panel Pen settings to adjust the display of electronic ink
from the pen and to modify the double-tap response.

Control Panel
Settings Help
o >
@Q L S 9
Fonts Ports tMouse Desktop Keyboard - To dlsplay Pen
@ (% ﬁ;_il B settings, double-tap
Printers Intemational  Date/Time Network Pen Handwriting this icon.
—— The Control Panel
Rotate Cif  ~PenInk - Pen Double-tap g:gﬁiaygotre Pen
c — Ink Width— —~Sample — Double-tap Area g '
Uslamize %, small Lorge
Double-tap Speed
r Ink Color ————
DDD.DD.D ‘ Slow Fast
([ [ [[ILL]
Press and Hold Time Delay
Short Long Try writing and selecting here:
[ 11 [°1 [SampleText
0K | Cancel | | Configure... g Help i

If your computer includes additional hardware settings, the Configure button at the
bottom of the Pen dialog box is enabled; if your computer does not have any
additional settings the button is disabled (dimmed). For information on the additional
hardware settings (if any) tap the Configure button and then choose Help.
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Changing Ink Settings

You may want to change the Ink Width and Ink Color settings to make it easier to
see the electronic ink that’s displayed on the computer screen when you print or
draw with the pen. Note that some computers with monochrome display screens may
offer very few color choices.

| To change ink width, tap this button.

- Pen Double-tap

—Sample Double-tap Area
L; . .
D Is,',"ﬂa" i"g,fg Changes to ink width and
color are shown here.

Double-tap Speed

OOOmOOED N

[ Ink Color

EEREEEER To change ink color, tap
| mear | the one you want.
Press and Hold Time Delay
Short Long Try writing and selecting here:
| Sample Text
’ OK ] [ cancet ] [Configure = | Help !

Changing Double-tap Settings

You may want to change the Double-tap Area and Speed settings if you are having
trouble double-tapping. For example, if you are experiencing difficulty when you
double-tap an icon to choose it, you should probably increase the double-tap area
and decrease the double-tap speed.

E__
-rPenlnk—M8M8¥ — Pen Double-tap———

Ink Width—  -Sample ( Double-tap Area
|
= |
Ik Color————_ et Bpeed -I To change double-tap
{ i N n E%ijji _J settings, drag these boxes.
ENERENER
To test your double-tap
changes, double-tap here.
r— Press and Hold Time Delay
Short Long Try writing and selecting here:
] Sample Text —]
| OK 5' | Cancelj] | Configure j [ Help 1
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Adjusting Press and Hold Delay

ext, you press and hold the pen at the
the selection arrow appears, and then you

By now you know that when you select t
beginning of the text. After a brief delay,

drag the pen to highlight all the text you want to select.

If you find that the sel

have a chance to draw a gesture) or too slowly, y
time delay. After adjusting the delay, you can practice se

sample-text part of the dialog box.

=
_pen Ink—————————  Pen Double-tap
Ink Width ~Sample Double-tap Area
[l% , Small Large
Double-tap Speed
- Ink Color ——————————
DDD.DD.D ’ Slow Fast
EEEREENE
 Press and Hold Time Delay
Short Long Try writing and selecting here:
[l TT—Ts] |Sample Text

I* OK4_}| Wncel J lzonfigure:] h Help J
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ection arrow appears too quickly (for example, before you
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Changing Handwriting Settings |

With the Control Panel Handwriting dialog box, you can choose settings that help

improve handwriting recognition and make it easier to choose commands. Because

others may use your computer, you might want to save personalized handwriting

settings for each user. i

=] Control Panel [ v]
Settings  Help
e
& T s
Fonts Poits Mouse Desktop Keyboard
W @ B s o <
Printers Intemational  Date/Time Metwork Pen Handwriting
£ e |
Rotate Calibrate 386 Enhanced  Drivers Sound |
\ 4
Customize desktop colors

=] Handwriting

User , OK ﬂ
[ =
Becognizer.'.ﬂ

~ Writing Hand Menu Style Dictionary... ﬂ
) B | |

|
|
r Recognize 1
[ When Pen is Lifted |
X After a Pause

Test Area: L —[ ";

Short Long 4

Changing Writing Hand and Menu Style

Since left-handed and right-handed people print many characters with slightly

different angles, most handwriting recognition programs adjust character recognition |
based upon the writing hand used. You can help improve handwriting recognition by |
choosing the correct Writing Hand settings.

You can make it easier to see commands in menus by choosing a Menu Style setting
that corresponds to your writing hand.
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Working with the User Options

The User options provide a method for saving all your personal settings under your
name. This is valuable if you often share your computer, and is especially useful for
saving your handwriting training.

Adding a New User

For each person who uses your computer, you should add a new user to the User
List. If you haven’t added a new user, you will be asked to add one when you use the
trainer to train the handwriting recognizer.

Handwriting

User

lTser 1 J_}__l

r Writing Hand —
m ’ New User Name:
- Recognize e — L
[] When Penis Liﬂﬁ User List:
X After a Pause J.Q. Public
Test Area:

Choosing Another User
The User names shown in the User dialog box match those you have set up with the

User List dialog box. To choose a new user, tap the arrow on the right in the User
box, and then tap the user name you want to choose.

Adjusting Recognition Time

The handwriting recognizer is set to pause briefly after you lift the pen and before it
recognizes your handwriting. You can remove the pause or adjust the delay. After
adjusting the recognition time, you can test it by printing in the Test Area below the
settings.
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= Handwriting

User o
l User 1 | ‘éj

Becognizer...i

[ Writing Hand Menu Style | Dictionary... |
| |£ _
Recognize
[ When Pen is Lifted
X After a Pause Short Long

Test Area: [ l

Control Panel Help

The following paragraphs describe other things you can do with the Control Panel
and show you where to find the information in Control Panel Help. To get Help on
the Control Panel, you must open File Manager and work with one of its windows.

Calibrating the Pen

The Windows pointer shapes (the pen and arrow) and electronic ink that are
displayed on your screen should follow very closely the point where you touch the
pen tip to the screen. If these shapes and ink are not closely aligned with the pen tip,
you should adjust the calibration of your pen.

* For information on: Calibrating the pen
See Help file: Control Panel Help
Topic: Changing Control Panel Settings

Calibrating the Pen
~ Search for: Cal

Rotating the Windows Display

With the Rotate icon, you can change the horizontal or vertical display orientation of
Windows and other applications on your screen. You may want to rotate the display
for applications that use a landscape (wider than tall) orientation, rather than the
common portrait (taller than wide) orientation.
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: For information on: Rotating the Windows display
g%gp See Help file: Control Panel Help
Topic: Changing Control Panel Settings

Rotating the Screen

Search for: Rot

Choosing Recognizers and Dictionaries

A handwriting recognizer translates your handwriting into text. Before displaying the
translated text, the recognizer compares it to sample text in a dictionary. Most pen
computing systems will include one dictionary and one recognizer. However,
because you may have additional dictionaries (such as a technical dictionary) or you
may want to switch between recognizers (from English to Kanji, for example), you
can choose the one you want from the Dictionary and Recognizer settings.

For information on: Dictionaries and recognizers

See Help file: Control Panel

Topic: Changing Handwriting Recognition Settings
T Searchfor: Hand

Using International Settings

With the International icon, you can change international settings, such as number
and currency formats, date and time formats, and country and language settings. You
cannot use this icon to change the language Windows uses; however, you can use it
to change the way applications sort and manage information for these international
formats.

For information on: International settings
See Help file: Control Panel
Topic: Changing Control Panel Settings

Customize Windows for International Use

" Search for: Int
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Managing Microsoft Windows

The Microsoft Windows graphical environment makes it easy to work with
application programs to create, revise, and produce various electronic files
(messages, documents, reports, illustrations, and so on).

To make it easy to organize programs and manage files, Microsoft Windows
contains three main management applications:

®  Program Manager

®  File Manager

®  Print Manager

Using Program Manager

When you start Microsoft Windows, the first thing you see is the Program Manager
window. The Program Manager displays program-item icons in group windows.
Each program-item icon represents an application. To start an application, double-
tap its program-item icon. Related application icons are grouped together in group
windows.

Program Manager ——|

Microsoft Pen Tools
group window

Program-item icons

Group windows

To start an application, double-tap its icon.

| —

Program Managear A
File Options Window Help

icons

=';l Microsoft Pen Tools via
Notebook Pen Palette Learning  Sample Form
Pen Basics
On-Screen Trainer
Keyboard
s Ga = a2
Az Avs Ave
StartUp  Applications Main Accessories Games

To open a group window, double-tap its icon.
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Program Manager contains six predefined group windows, each of which has its own
set of icons.

® The Microsoft Pen Tools group window contains the Pen Palette and applications
for learning how to use the pen, the on-screen keyboard, and the trainer.

m The StartUp group window contains icons for applications that automatically
start when you start Windows, such as the Pen Palette icon, which is displayed at
the bottom of the screen.

m The Accessories group window includes icons for Windows applications such as
Microsoft Write, Microsoft Paintbrush, the Calendar, Calculator, and so on.

m The Main group window contains the Windows system applications: File
Manager, Print Manager, the Control Panel, and so on.

m The Applications group window contains icons for additional applications.

® The Games group window contains icons for whatever computer games you have
on your system.

Creating a Group Window

You can change the number and type of program-item icons in any existing group
window and create your own group windows. To make it easier to find the program-
item icons you frequently use, you may want to group them together.

The following illustrations show you how to create a workgroup group window that
displays program items for applications you might use to prepare a group report.
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Creating a New Program Group

The first step in creating a group window is to create and describe the new program
group. For this example, the new program group is named “Workgroup.”

1. To create a new group, choose 2.To choose Program Group,
New from the File menu. tap here and then tap OK.

B Program Manager
(&8 Options Window Help

Enter
F7

F8

Del
Properties... Alt+Enter
Run...
Exit Windows...

(=} Progra oup

Description: lWori(group —I | OK 7
Group File: | | |

3.Print the group name,
and then tap OK.

Program Manager displays the new, empty group window (as shown in the following

illustration).

Moving Applications to the Group Window

The following illustration shows you how to move application program items
(Microsoft Write and Paintbrush) from an existing group (Accessories) to the newly
created group window (Workgroup). If you want to copy a program item to a new
group while leaving a copy of the program item in the existing group window, you

must use the Copy or New commands on the File menu.
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To move an application icon to another group, open both
group windows and drag the icon to the new location.

doXoligt: anage i a

File Options Window Help
= Main |
= | @@= = = MR :“_

F“J;T IAccessories
72 )
L

&
{ Teminal Notepad Recorder
W {:.ﬂ Workgroup
L_ @ =\
S®
Cardfile
Paintbrush

StartUp  Applications Main Accessories ~ Games

Exiting Program Manager

You start and end every Windows session with Program Manager. Even when you
are using other applications, Program Manager remains running in the background.
When you quit Program Manager, you also quit Windows.

To exit Program Manager and quit Windows,
choose Exit Windows from the File menu.

=/

File

Program Manager
Options Window Help

New...

Open Enter t Pen Tools Vlﬁ

Delete Del @ @
Properties... Alt+Enter | Leaning Sample Form
Pen Basics
Run...
o[
On-screen Trainer
Keyboard

a
A

StartUp  Applications Main Accessories Games
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Program Manager Help

The table below describes other things you can do with Program Manager and
shows you where to find the information in Program Manager Help.

To get Help on Program Manager, you must be using Program Manager or one of

its group windows.

For information on

See Help topic

Starting and working with
multiple applications

Working with multiple
windows

Adding a document to a group
window

Modifying program-item icons

Working with Applications and Documents
Starting Applications

Getting Started with Program Manager
Arranging Windows and Icons

Organizing Applications and Documents
Adding a Document as a Program Item

Organizing Applications and Documents
Changing Properties
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Using File Manager

File Manager provides a graphical way to organize and view the files contained in
directories. A file is an electronic document or an application that has been given a
name and stored on your computer. Like file folders, directories provide a
convenient way to organize and locate your files. Directories can contain both files

and other directories (called subdirectories).

Starting File Manager

The File Manager icon is available from the Program Manager Main group window.
To start File Manager, double-tap the File Manager icon.

To start File Manager, double-tap its icon.

Program Manager
File Options indow Help

=i Main E'_IA
g B S B

File Manager Control Panel  Print Manager  Clipboard MS-DOS
WViewer Prompt

Fad \
Windows PIF Editor Read Me :
Setup ‘

2
AZO

StartUp  Applications Workgroup  Accessories

In File Manager, directories and files are displayed in a directory window. Near the
top of the directory window is a group of icons that represent available disk drives.
The current drive is enclosed in a rectangular box. For example, in the following
illustration the icons show that there are three available drives: drive A, for a floppy
disk; drive C for the hard disk; and drive D, for the network. The rectangular box
around drive C indicates that it is the current drive.
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= File Manager

File Disk Tree View Options Window Help

c:\windows\*.*

E=3A[=Ic] =Ip

Current drive

_ calc.hlp

File Manager
directory window

Current directory

i EJcalendar.exe

—E finance -
—(C) homework () system
—(C mail 3270.1xt
—ﬁnewart D accessor.grp
a?..?‘.’.‘[‘.‘.’?ﬂ’_i [ applicatgrp
£ system boxes.bmp

—[i] notebook 3 ] calc.exe charmap.hlp
E [ [«]

[ Jcardfile.exe
cardfile.hlp
[ charmap.exe

==
calendar.hip

==

E

The main part of the directory window is divided in half. The left half of the window

displays directories and the right half displays the files and subdirectories contained *
in the current directory. For example, in the illustration above, the right half of the

window shows the files and subdirectories contained in the Windows directory on

drive C.

Files and subdirectories
in the current directory. |

{
|
|
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Viewing Directory Contents

To view the contents of a directory, tap the directory name or its icon in the
directory window. To view files in a subdirectory, tap the subdirectory name or icon.

= File Manager
File Disk Tree View Options Window Help

=JA[=Ic] =D

c:\windows\*.* ] ]

|

I

I

|

I

7Y |

—(=7) finance A calc.hlp I

() homework Esystem Jcalendar.exe :

3270.txt calendar.hlp =) (!

D accessor.grp Flcardfile.exe [ :

D applicat.grp cardfile.hip == 1

boxes.bmp 1 charmap.exe :

T [ calc.exe charmap.hip E lI

« [+ ||« >

|

T P |
To view files in this To see more files,
subdirectory, tap it. tap the scroll bar.

If there are more files or directories in a directory window, you can use the scroll
bars to see them. To scroll a window, tap the scroll arrows or drag the scroll box.
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Directory and File Icons

To help you identify subdirectories and file types, each File Manager directory
window displays an icon to the left of each directory or file name. The following
table describes these icons.

Icon Represents

I:I Directories. These are listed first, in alphabetical order.

Document files. These files are associated with an application.When
you double-tap a document icon, the application starts and opens the
document.

E Program files and batch files. With filename extensions of .EXE,
.COM, .PIF, and .BAT, these files start programs.

D System or hidden files.

D All other files.

Filenames

All Windows filenames follow the MS-DOSe rules for naming files. Keep the
following in mind when creating, copying, or renaming files:

® A file or directory name consists of two parts: the name of the file and the
optional extension. The two parts are separated by a period. For example,
MYFILE.WRI is a valid MS-DOS filename; MYFILE is the name of the file and
-WRI is the filename extension that Microsoft Write adds to the filename. Some
other examples of valid filenames are LETTER.DOC, BUDGET.92,
MEMO.TXT, DEMO.FUN.

®  The name can contain up to eight characters, and the extension can contain up to
three characters. These characters can be entered in either uppercase or
lowercase.

®  The name should start with a letter or number. It cannot contain any spaces or
any of the following characters: period (.), quotation mark (), slash (/) backslash
(V), brackets ([]), colon (:), semicolon (;), vertical bar (1), equal sign (=), or
comma (,).

m  The following names are reserved, and cannot be used for files or directories:
CON, AUX, COMI, COM2, COM3, COM4, LPT1, LPT2, LPT3, PRN, and
NUL.
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Searching for Files

To find a file or group of files, you can use the Search command on the File menu.
The Search command displays filenames in the Search Results window. From the
Search Results window, you can open, print, copy, move, delete, or rename any of
the files.

You can also find groups of files that have related filenames or extensions by
substituting the * wildcard for various characters in a filename. For example, as
shown in the following illustration, you can search for all files that end with the
.BMP extension.

A 1.To search for files, choose
[l Search from the File menu.

/i
5/

=W Disk Tree

File Manager
View Options Window Help

Open Enter 1
Move... F7 !
Copy... F8 I|
Delete... Del |
|
|
|

2. Print the name of the
file you want to find.

Rename...

Properties. .. Alt+Enter
Run...

Print...

Associate... Search For: [Fomp
Create Directories. .. Start From: [Ciwindows

£E S Rsearch All Sub-directories
Select Files...

Exit

e He o [0 pmp v

c\windows\boxes.bmp

c\windows\chess.bmp -\mﬁ d%ﬁmgpﬁ:;:l;ﬁ
c\windows\neman.bmp the files that end
c\windows\paper.omp with the .BMP
c\windows\party.omp filename extension.
c\windows\pyramid.bmp
c\windows\weave.bmp

DODDEDD g
L=

<

4
L
a
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Copying and Moving Files

You can copy and move files from one File Manager location to another by selecting

the files and dragging the file icons.

When you drag file icons between directories on the same drive, File Manager
assumes you want to move the files and displays a message asking you to confirm
the move. If you want to copy files to a different directory on the same drive, you

must use the Copy command on the File menu.

The illustration shows you how to move a file to another directory on the same drive.

File Disk Tree View Options Window Help

= File Manager

c:\windows\*.*

E=3A [=I¢] =D

accessor.grp
applicat.grp
boxes.bmp

) notebook 3 ] calc.exe

: [ ]calendar.exe

calc.hlp

[ Jcardfile.exe

cardfile.hlp

[ charmap.exe

charmap.hlp

=
calendar.hlp

e

E

|
|
I
|
|
|
|
|
|
|
I
I
|
|
|
|
|
|
|
|

To move a file to another dirctory
on the same drive, drag the file icon
to the directory icon.

When you drag file icons to directories on a different drive, File Manager assumes

you want to copy the files and displays a message asking you to confirm that you're
copying. If you want to move files to a directory on a different drive, you must use
the Move command on the File menu.
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The illustration below shows you how to copy a file to a disk in drive A. Notice that
it shows both the source directory (the directory that contains the file you want to
copy) and the destination directory (the directory where you want to place the copied
file) on the screen. If you cannot see both directories, use the Tile or Cascade
command on the Windows menu to make them visible.

1. To copy files to another drive, open both
the source and destination directories.

= File Manager
File Disk Tree View Options Window Help
= ai\*.* lz_l A
Disk in drive A——ile=1A| =JC [=ID A:
Destination directory a\ £ Jan92.doctxt

Feb92.doctxt
- Mar92.doctxt
3 April92.doctxt

— & £ hd VS
=IA =o c
D N e £ f
Source directory ] finance
—(") homework
) mail 2
. B E

2. Drag the file icon from the source
directory to the destination directory.
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File Manager Help

This table describes some of the other things you can do with File Manager and
shows you where to find the information in File Manager Help. To get Help on
File Manager, you must open File Manager and work with one of its windows.

For information on See Help topic
Opening a file and starting an Working with Files and Directories
application at the same time Associating Files with Applications
Selecting multiple files Working with Files and Directories
Selecting Files
Creating a new directory Working with Files and Directories
Creating Directories
Working with floppy disks Managing Disks
Formatting a Floppy Disk
Using drives on a computer Moving Around in File Manager
network Connecting to and Disconnecting from

a Network Drive

Using Print Manager

Print Manager is the Windows application that manages printing. With Print
Manager, you can install and set up printers, connect to network printers, and control
the printing of your files.

When you print a document from a Windows application, the application sends
information—about the printer, font, and file—to Print Manager. Print Manager
works in the background, sending your files to the printer while you continue
working with your other Windows applications.

Activating Print Manager

To activate Print Manager, you use the Printers icon in the Control Panel. The
Control Panel is available from the Program Manager Main group window.
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1.To open the Control Panel, tap here.
= Pfogram Manager [w]a
File Options Windp / Help
= | Main [»]a

g = & [ W

File Manager Control Panel Print Manager Clipboard M5-DOS
iewer Prompt

Control Panel

Settings . Help

& o O O =

Cal / Fonts Ports Mouse Desktop Keyboard
¢ ® | w o %
A i

] W 7 3 = >
Printers Intemational  Date/Time MNetwork Pen Handwriting
> © B £

aP [l a(

& i * g “—C
Rotate 386 Enhanced  Drivers Sound

Changes the Windows screen colors

2.To open the Printers dialog box, double-tap here.

Default Printer E c !

[ HP Laserijet Il J lose

Installed Printers: Connect ﬂ

HP Laserjet lll

7//7 Set As Default Printer |

|
gUse Print Manager

Remove |

3.To activate the Print Manager, tap this option.
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Checking Printer Status

To check the status of files printed using Print Manager, tap the Print Manager icon
in the Program Manager Main group window.

To use Print Manager, tap here.

=] Mai [x]a

o & =
EI (=) .
Vs |
File Manager  Control Panel  Print Manager  Clipboard MS-DOS
iewer Frompt

Print Manager

View Options Help
_|_BResume | Delete
The HP Laserjet lll on LPT1(Local) is idle

|| The HP Laserjet lll on LPT1(Local) is idle

Haln
»g %;i( %« Here are some things for which you can find information in Print Manager Help.
“ To get Help on Print Manager, you must open Print Manager.

T T

For information on See Help topic

Installing and configuring a Basic Skills

printer Installing and Configuring a Printer
Using a printer on a network Basic Skills

Printing on a Network

Messages from Print Manager Basic Skills
Displaying Printing Messages
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Using Microsoft Notebook

Microsoft Notebook is an accessory for organizing and managing information. It is
divided into pages that you can fill with text, freehand drawings, or embedded
objects—text and graphics—from other applications. Notebook also contains a
calendar where you can track appointments and tasks.

= Notebook - Schedules v|a |
Page Edit Format Options Help ‘

EEEI=IEN 4 [Arial ][4 [12 ¥ [B]7]v]

Revised Schedules o H86/4C
- to Fab 4/19
-to QA 4/30

- to Mfg 517 e e

. HO7
See Jim S w07

for second sources

mnn L%ntents&lendarl l l

Note Microsoft Windows for Pen Computing comes with several accessories and
games. To find out which accessories and games you have, open the Program 1
Manager Accessories and Program Manager Games group windows. For information I
about an accessory or game, start it by double-tapping its icon. Then choose
Contents from the Help menu.
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Starting Microsoft Notebook

Microsoft Notebook is available from the Microsoft Pen Tools group window.

/I To start Notebook, double-tap its icon.

Microsoft Pen Tools —

Notebook Pen Palette Learning Sample Form

&

On-screen Trainer

Keyboard

Pen Basics

When you start Notebook, the Table of Contents is displayed.

Text tool

Shape tool
l Freehand tool

l Font box

Size box l Text style buttons

Format Options Help HE
Notebook tool bar —[ @ El Arial IE| @@ B|I Ip]
e PRI Table of Contents
Page name . .
Page number button -
Page tabs
Next page
Current page
Previous page l
Backtrack 4 4 » Contents | Calendar l ]
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Notehook part

How to use it

Notebook tool bar

New page button

Page name

Page number button

Page tabs

Next page
Current page
Previous page
Backtrack
Navigation bar

Text tool
Shape tool

Freehand tool

Font box
Size box

Text style buttons

Tap appropriate buttons or arrows in the
tool bar to change the format of text and
drawings in Notebook.

Tap the New Page button to add a new
page after the selected page in the Table of
Contents.

Double-tap a page name to display the
page. A new page is titled Note Page until
you give it a name.

Tap a page number button to display a
page.

Tap a page tab to display a named page.
To create a new page tab, tap a blank page
tab.

Tap Next page to display the next
Notebook page.

Print a number in the box to display a
specific page.

Tap Previous page to display the previous
Notebook page.

Tap Backitrack to display the last page you
used.

Tap the buttons in the navigation bar to
move around in Notebook.

Tap the Text tool to recognize text.

Tap the Shape tool to recognize standard
shapes.

Tap the Freehand tool to convert shapes or
text back into ink.

Choose the text font you want.
Choose the font size you want.

Choose bold, italic, or underline text
styles.
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Moving Around in Notebook

The following illustration shows you three ways to move around in Notebook:
= Tap buttons in the navigation bar

m Tap page names and numbers in the Table of Contents

m  Tap page tabs

Using the Table of Contents

The first page of Notebook is the Table of Contents, which is similar to the table of
contents of a book. Each page in Notebook is listed with its page number. You tap a
page number to turn to it. From the Table of Contents, you can add, move, copy, or
delete pages. For more information, see “Working with Pages,” later in this chapter.

To move to a specific page,
tap the page number,

double-tap the page name,
l or print the page number here.

= oiepnoou apie 0O U < i A

Page Ed at Options Help

For
= [—— 13 [Arial__|M[2]¥ [B]r]X

Table of Contents
:

= Note Page {- - '

s o] [comensfoamnaa] war [ [ ] J

To move to the next page, tap here.
To move to the previous page, tap here.
To move back to the last page you used, tap here.
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Using the Navigation Bar

The navigation bar includes buttons for backtracking and for turning to the next and
previous pages. In addition, you can create page tabs that you tap to move to pages
that you use frequently. The Contents and Calendar tabs have already been created
for you.

To create a page tab, tap any blank page tab on the navigation bar or choose the Page
Tabs command from the Format menu. In the Tab Name list box, choose the page
you want to appear on the page tab in the navigation bar. Then print the tab name
(up to eight characters). You are limited to six tabs, including the Contents and
Calendar.

1. To create a new page tab, tap one of the

2. Print a name for the page
blank page tabs on the navigation bar.

tab (up to 8 characters).

= DIeD0O0 dDieé O O < Vi oA

Page Edit Format Options Help

EERIEIEE I==cicoNciarionn
=] Page Tabs =

(=) Mail messages -...ooeeeueen.. |

A — el =
LI T R ——— il T Tl B | B | Cancel ﬂ -------
| [S—— Contents Coptents | | = [f---eee-
= 5/23 Team Meeting .............. Calendar Calendar Preview [ [l
o Scheculcs B || ’ [Erevew ] |-
@ Resources . [ [<Blank> |
®spB0TeamMeeting .|| ———————— | | |
= Quality Gircle Notes____ GotoPage: | | | |~
. s 1S |
= Part # questions L1 1| L LA | I | .
u  Note Page .-ccccceeeeeee Page Name: Schedules [ [ |
m’n’-n Contents | Calendar l L L L J ‘
Page tabs display 3. Print the page 4. If you want to view the 1
pages you number, or page before assigning it
frequently use. choose a page to a page tab, you can
from this list. tap the Preview button.
5. Tap OK to create the Page tab. ‘
" Forinformation on: Creating a button to display a specific button It
Change Page Tabs |
See Help file: Notebook Help ‘
- |
Topic: Moving around in Notebook
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Writing and Drawing in Notebook

Because Notebook is a computer application, it offers many advantages that are not
available with the typical paper notebook or calendar. You can write and draw in
Notebook and leave the handwriting and shapes as “electronic ink™ or you can
recognize them and display them as text objects and shape objects. For more

information on objects, see “Working with Objects,” later in this chapter.

- Notebook - Schedules
Page Edit Format Options Help

ERRIEIEN RS 3 [Arial _][# 12 ]38 [B]] ]

Recognized text Revised Schedules
“toFab 419 #HB6/HC
-to QA 4/30
~toMfg 517
Recognized shapes B @

in a drawing

. HO/
See Jim Il

Handwritten text
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Erasing Ink

You can erase the electronic ink that is displayed when you write and draw in
Notebook. To erase ink, press the barrel button on the pen. The cursor changes to an
eraser. Drag the eraser over the ink you want to erase.

You cannot use the eraser with recognized text and objects. To erase objects other
than ink, select the object and then draw the Delete gesture or choose the Delete

command from the Edit menu.

=i Notebook - Schedules
Page Edit Format Options Help

EERI=1ERC N

— [#] [Arial

Revised Schedules

-to Fab 4/19

-to QA 4/30

- to Mfg 517
See Jim

for second sour

®

HO73 #0074

J

¥ oty

4 412 |» [Conlents Calendar

el

You can erase ink
(handwritten text
or drawings).

To erase ink, hold down the barrel
button on the pen, and then drag the
eraser over the ink you want to erase.
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Recognizing Handwriting

You can recognize your handwriting and translate it into text. This is useful when
you want others to read what you have written or when you want to use your text in
an application that does not work with electronic ink. For example, you may want to
copy recognized Notebook text to a document in a word processing application such
as Microsoft Word for Windows.

To recognize handwritten text or shapes, tap the pen on the ink you want to
recognize and then tap the Text tool on the tool bar. The recognized text replaces the
handwritten text.

To undo recognized text or shapes and display the original ink, select the recognized
object and tap the Freehand tool or choose the Undo Conversion command from the
Edit menu.

1.To recognize text, tap the ink to select it.
2. To translate the ink, tap the Text tool.

To undo recognition and display the original
ink, tap the Freehand tool.

Notebook - Schedules
Page [Edit Format Options Help

el [ [ M ——18 [Aia_ (2] [B[7]Y]

Revised Schedules

-to Fab 4/19 0 HBO/MC
-to QA 4/30

- to Mfg 5117

©

i o HO7
"ok Jim #0753 w074

for second sources

T e oy D G W S

The size of recognized text is relative to the size of the letters you print; that is, the
larger you print, the larger the recognized text appears. To turn off this feature,
choose the Automatic Text Size command from the Options menu.
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Recognizing Drawings

When you recognize freehand drawings, Notebook attempts to convert them to
typeset shapes. To recognize a freehand drawing, tap the shape to select it and then
tap the Shape tool on Notebook tool bar.

To recognize a drawing that consists of many shapes and letters, you must draw and
recognize each shape and letter in the drawing individually. The illustration shows
how to recognize the circled letters in a chart.

1. Print an "A," and then select the ink.
l 2. To recognize the letter, tap the Text tool.

: Notebook - Schedules
Page Edit Format Options Help

[t]=o]a] [—— 13 [Aval_ ¥ [2 Y B[2]Y]

A ®

3. Draw a circle around the letter, 4.To recognize the circle,
and then select the ink. tap the Shape tool.

Note For the recognizer to recognize a shape, the drawing must very closely
resemble standard shapes such as rectangles and circles. If the shape you draw is
imprecise, the recognizer will ignore it and leave it as electronic ink.

For information on: Working with ink or recognized objects
See Help file: Notebook Help
Topic: Getting Started with Notebook
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Working with Text

When you rec

ognize handwritten text, it is translated into fext objects that you can

edit, copy, or move. You can also change the size and appearance of text by

selecting the t

ext and then applying a font, size, and style to it.

Editing Text

You can use gestures in Notebook to edit or correct recognized text. To correct a
word, draw the Edit Text gesture through the word. Then use the Edit Text dialog

box to make changes.

1.To correct text, draw the Edit Text gesture
(a checkmark) through the word you want to correct.

Page Edit

oteboo ed € Via

Format Options Help

(W] 3 [Aar |23 [B]r]Y]

to Fab
to QA
to Mfg

Revised Sghedules

4/19
4 |
517

Edit Text

Cancel

| |Content

2. Write over the text 3.Tap OK to correct the text and
you want to correct. close the Edit Text dialog box.

In the Edit Text dialog box, you can write over incorrect text use gestures, or tap the

Clear button.
tap the Help

For more information on gestures, see Chapter 3, “Using Gestures,” or
menu and then tap the Gestures button for an online description.

If you write new text using the Edit Text dialog box, draw the checkmark when you
want to place the new text on the page. Print the new text in the letter guides.
Remember that the text size is determined by the tool bar settings.
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Selecting Text

In Notebook, as in other applications in Windows for Pen Computing, to select text,
you tap the recognized text object. Lift the pen. Tap and hold down the pen tip at the
beginning of the text you want to select. When you see the arrow pointer, drag the
highlight until it covers all the text you want to select, and then lift the pen. The
selected text stays highlighted until you draw a gesture or choose a command.

To correct multiple words, select the words and then draw the Edit Text gesture over
the selection. Change the words in the letter guides. To change the appearance of
existing text, select the text and then choose the font or style you want to apply.

1. To select text, tap and hold 2. When you see the arrow pointer,
the pen tip at the beginning drag the highlight until it covers
of the text you want to select. the text. Then lift the pen.

=] Notebook - Schedules
Page Edit Format Options Help

BER | 13 [Arial ][4

Revised Schedules
to Fab 4/19
to QA 4/3@

to Mfg 517
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Finding Text

You can quickly locate recognized text on any page in Notebook by using the Find
command on the Edit menu. You can search for recognized text only—the Find
command cannot find ink on a page. Print the text you want to find in the Find

dialog box and tap OK.

When you locate the page that contains the text you want, tap anywhere on the page

to end the search.

To search for text in the Calendar, you must first display a Calendar page. For details

about the Calendar, see “Working with the Calendar,” later in this chapter.

1. To find the pages that contain specific
text, choose Find from the Edit menu.

= otenda

Page f=eif§ Format O

tions Help

ab|p| Undo
Cut

Copy
Paste

=13 [Arial (¥ [12]8]

bR

bf Contents

Insert Object...

Import Object...
Delete Object  /f =
Clear Page /)

Edit Object

= Quality Circle Notes

= Part # questions

= Note Page --------

Find What:

(u,rg,ent,

4 Cnel ]

I P

et

|

[0 Match Case
Searching Page:

[0 Match Whole Word Only

Direction
[Ogackward @ Forward

2. Print the text you
want to find and
then tap Find Next.

3. When you find the text,
tap cancel to end the
search.
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Changing Fonts and Styles

You can change the appearance (often referred to as the format) of recognized text
by choosing a different text type (called a font), changing character size, and adding
emphasis with bold, underlined, and italic text styles.

To change the format of existing text, select the text and then choose a format from
the boxes and buttons on the tool bar.

2. To change text type, tap
1. To change text appearance, the Font box, and then
select the text. tap the desired font. }

3. To change text size, tap
the Size box, and then
tap the desired size.

—=

ge Edit Format Options Help /
[—— 18 [Arial__ | (12 |3

Revised Schedules
to Fab 4/19

to QA 4/3
to Mfg  5/17

’\.._\\
»

4. To change the text style, tap the
Bold, Italic, or Underline button.

Formatting New Text

You can determine the format of new text before it is recognized by choosing the
formatting from the tool bar after you select the electronic ink. When you recognize
the new text, it is displayed in the text type, size, and styles that you chose. For
example, if the tool bar indicates Arial in the Font box, 12 in the Size box, and the U
(Underline) button, the next text you recognize will be displayed with Arial 12-point,
underlined characters.

Using the Format of Existing Text

A quick way to format new text is to select existing text that contains the format you
want. When you select the existing text, the new format is shown on the tool bar.
Then, when you recognize new text, it is displayed in the text type, size, and styles
of the existing text.
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Undoing the Last Action

Undo reverses the most recently completed command or action. If you don’t like the
results of a command or you accidentally delete some text, choose Undo as the next
action. You can also draw the Undo gesture or choose the Undo command from the

Edit menu.

Note If you undo recognized text and display ink again, you lose any formatting
you may have added to the recognized text.

To undo an action, choose Undo from the Edit menu
or draw the Undo gesture (as shown in the menu).

i
— / U e D00 2 U VA
Page [=s[i# Fj/rmat Options Help
ab [y ao O
Cut S
Copy &
Rev' Paste A
t0 I Insert Object...
to ( Import Object...
to| Delete Object i
Clear Page
- —-—-- EditObject = -—-—-~-"~"~--~-~-~-~-~--~--77°7°7
Find...

Performing Calculations

You can perform basic calculations while working in Notebook. To do so, you print
numbers separated by an operator (addition, subtraction, multiplication, or division
sign) and followed by an equal sign. You then recognize the handwritten equation.
Notebook performs the calculation for you and displays the results.

To subtract numbers, separate them with a minus sign (for example: 137-12=). To
multiply numbers, separate them with an “x” (for example: 137x12=). To divide
numbers, separate them with a slash (for example: 137/12=).
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1. To do calculations, print an equation. 2.To select the ink object, tap it.

Notebook - Schedules
Page Edit Format @ptions Help

137 + 12 =149

3. To recognize and finish the
calculations, tap the Text tool.

" For information on: Using gestures in Notebook
See Help file: Writing in Notebook
Topics: Aligning Text and Setting Indents
e Notebook Help

Working with Text

Working with Pages

Each Notebook page is listed in the Table of Contents. To get to a page quickly,
double-tap the page name or tap the page number in the Table of Contents. You
“turn” to that page immediately.

You can add pages, change page names, delete pages, and move pages. Notebook
automatically updates the Table of Contents to reflect any changes.
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Adding a Page
You can add blank, numbered pages by tapping the New page button on the tool bar
or by choosing the New Page command from the Page menu.

When you add a new page, it’s inserted after the current page. When you add a new
page from the Table of Contents, the new page is added after the selected
(highlighted) page. A new page is titled “Note Page” until you give it another name.

The illustration shows you how to add a page from the Table of Contents.
To turn to a page,

To start a new page, tap double-tap the
| the New page button. page number.

/‘Notebook - Table of Contents A
gormat Options Help

= [—— 13 [Arial_][H[12 [
Table of Contents !

DIl Note Page [ SO
@

= Note Page - emseaemassmemmpas e A S £ e ekt e s s eme s e S

M ILContents Calendﬂ J J

To add a page, tap
) the New page button.

/”“Notebook - Table of Contents
pormat Options Help

0 W 8 (Ana 30218 [B[1]Y]
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Naming a Page

You can name the pages in Notebook. For example, a page containing text from
electronic mail could be called “Mail Messages.” You can use up to 64 characters,
including spaces, for a page name. You can name a page in the Table of Contents or
while you’re using that page.

To name a page while you’re viewing the Table of Contents, tap its “Note Page”
name in the Table of Contents and then choose the Name Page command from the
Page menu. To name a page you’re using, choose the Name Page command from the
Page menu. In the Name Page dialog box, print a name for the page by writing over
the existing name.

1.To name a new page,
tap the Note Page name.

I 2. From the Page menu, tap Name Page.

Notebook - Table of Contents [v]a
e[l Edit| Format Options Help

e bae 1 [l [z 1

Delete Page
Go to Table of Contents Table of Contents

Go to Page

Go to Calendar
Show / Hide Subpages
Go to Header Page
Header Page List...
Print...

Print Setup...

Exit

mn-n Contents | Cal

Name page

3. Print the name, and then tap OK.
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Organizing Pages

You can organize Notebook pages in levels similar to an outline, with less important
pages indented below the pages that introduce them. The top-level pages ar¢ called
header pages; indented pages are called subpages (subordinate pages).

Each page has a handle. Header pages are designated with larger handles, which you
can use to collapse or expand the Table of Contents and hide or display subpages.

You can rearrange pages or entire sections and retain their existing internal order. If
you want to focus on specific sections of the Contents, you can hide subpages.
Headers that have no subpages are displayed with a small handle.

rmat Options Help

Table of Contents

Header page handle = Mail S —
= 41

Subpage handle 4115
LR, I

(=) 5/23 Team Meeting ....
m  Schedules ...

Header page with
hidden subpages

& Resources _____.._......
= 5/30 Team Meeting ________....
Quality Circle Notes ___

Subpages

|: Part # questions._.
NOtE PAGE ---evneseermmmmmrrmsssnsamssnsssassssmmsses

| |Contents Calendar
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Creating Header Pages and Subpages

To create a header page, indent the page below it. To indent a page, tap the page
handle to the left of the page name. When crosshairs appear, hold the pen tip down
and drag the handle to the position you want. Then lift the pen.

1.To create a header page, tap and hold the page
handle (it turns into a 4-sided arrow pointer).

c Notebook - Table of Contents [ v] 4]
age Edit Format Options Help

[elolel O [0 (W [——1¥ (e J6I 28l (B0

Table of Contents

1

==

R ERIRNEED T e s |

2.Drag the page handle to the right (it turns
into a crosshair), and then lift the pen.

To create a header page from a subpage, drag the subpage to the left and line it up
with other header pages, as shown in the following illustration.
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1. To create a header page from a subpage, tap and hold
the page handle (it turns into a 4-sided arrow pointer).

Notebook - Table of Contents

Edit Format Options Help -

TR N=IE o] [Arial (¥ [12 Y

@ /23 Team MEEtNG ...ooceeeeeeocmmeememeeemerememomaeeees

frnl
jes)

il r je
= 41
" 415 ..
BB o oceessssegssi s

+ Table of Contents
3

= Schedules
® Resources
F) 4/30 Team Meeting
= Quality Circle Notes __

(ad

P
Part # questions ...
Note Page --------

1
+

4] ¢ » llContelﬂCalendﬂ l
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2. Drag the page handle to the left
(it turns into a crosshair).

3. When the crosshair lines up with the other
header pages, lift the pen. The subpage turns
into a header page with a larger page handle.
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Expanding and Collapsing Page Levels

You can show or hide page levels in the Table of Contents by collapsing and
expanding them. You may want to do this to see only top-level pages, or to see only
the pages related to a specific header page.

To hide (collapse) a topic’s subpages, double-tap the header page handle. Header
pages that contain hidden subpages are designated with a plus sign (+) in the page
handle. To show all (expand) the subpages, double-tap the plus sign in the header
page handle.

To show all (expand) hidden subpages below a
header page, double-tap the header page handle.

t Notebook - Table of Contents [+~
Page Edit Format Options Help

[l (D[S (W [——T¥ [Avia 3 [ J3 [B7Y]

Table of Contents

& Mail messages
=41
= 4/15
= 51
(= 5/23 Team Meeting
= Schedules
—3 Resources
= 5/30 Team Meeting
®  Quality Circle Notes
= Specs
= Part # questions
= Note Page

| mn-u lgontemsﬁlendarL l I l J

To hide (collapse) all subpages below a header
page, double-tap the header page handle.
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Moving a Page or Group of Pages

You can move a page while you are in the Table of Contents. To move a header

page and its subpages, tap the header page handle to select all the pages and then
drag the crosshairs to where you want to place the pages. When you lift the pen tip,

the pages and any subpages move to the new location.

1. To move a header page and all its subpages, tap
the header page handle to select the pages. The
4-sided arrow pointer appears over the handle.

— o1epou dDIC

A_Page Edit Format Options Help

0 O < Vi A

mE E=EIERC] 3 [Aral |3 [2 4

Table of Contents

Mail messages

/ = Schedules

Resources

5F] 5/30 Team Meeting __

= Quality Circle Notes ___

Specs __

L}
= Part # questions
m

Note Page --

==

| |Contents ‘ Calendar

2. Drag the header page handle and place
the intersection of the crosshairs where
you want to move the selected pages.

3. To move the pages, lift the pen.

" For information on: Selecting, hiding, and changing page levels
See Help file: Notebook Help
Topic: Moving Around in Notebook

s ——"
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Deleting a Page

There are two ways to delete pages: from the Table of Contents and from the page
itself. To avoid deleting important information, it’s a good idea to review a page
before deleting it.

To delete the current page, choose Delete Page from the Page menu. Associated
subpages are also deleted.

The illustration shows how to delete a page from the Table of Contents.

1. To delete a page from the Table of Contents, select the page name.
2. From the Page menu, choose Delete Page.

Notebook - Table of Contents
Format Options Help

B (Aa @[z 3 [B]7]Y]

Table of Contents

New Page
Name Page

dade

Go to Table of Contents
Go to Page

Go to Calendar 1
Show / Hide Subpages |- wwswesereeeeeee oo
Go to Header Page ;
Header Page List...

o TN - = Delete Page
Print Setup... [
Exit

Delete page 2: "Note Page"

mn-n M l OK gl Canceﬂ

NI O [LO|N!

3.In the Delete Page box, tap OK.

vv +  Forinformation on: Adding pages
ggg} See Help file: Notebook Help
: Topic: Working with Text
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Working with the Calendar

Notebook contains a calendar where you can list appointments and reminders. The
Calendar automatically displays the Day view for the current date, but you can
quickly move to another day in a different month.

Notebook - Calendar
Page Edit Format Options Help

lefofal [ [ (M) [——]4 [Aval ]3] [i2 |8 [B]7]U]

Reminders Hours Wednesday, May 13, 1992

1 Memo to T 7:00
2 Create graph 8:00
3 Meet w/Bill 9:00
4| Printer 0:00 Team mtg 5 - 44079
:00 bring memo
:00
:00 | lunch at Zeno's
4:00
4 May, 1992 15:00
16:00
S M T W T F S [17:00 | haircut - 555-1673
18:00 A
1 2 19:00
3 4 5 6 7 8 9 [2000 /
10 11 12 13 14 15 16 | 21:00 f
17 18 19 20 21 22 23 | 22:00
24 25 26 27 28 29 30 | 23:00 /i
2000 | ff

m D 2 S W W W

To change days, tap | To display the Calendar, tap here.
here or tap the day
you want to see.

To change months, tap here.

Note Notes that you write in the Reminder do not change when you display another
date.
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Displaying Month View

To display a view of the Calendar by month, choose Show Month View from the
Options menu, or tap the Month button.

To display the Calendar Month
View, choose Show Month
View from the Options menu. ..

— O SHololNe c Ud Vi A
Page Edit Format Heaie Hel /
Show Page Breaks ' I | 3]
Reminders Ins.ert Us.m gn_d / day, May 13, 1992
Automatic Recognition
Automatic Text Size
:00
:00
:00
4:00
. May, 1992 [ pi 15:00
16:00
_SM T W T F_ S [F700

or tap here to display Month view.

As shown in the following illustration, you can write in Month view. Notes that you
write in Calendar view do not appear in Day View.

, To display another month, tap these buttons.

Notebook - Calendar
Page [dit Format Options Help

EEEI=EIE ¥ [Aral |3 [i2 Y
A|<I>r May, 1992 Jun

(5] (4] [5] [6] (7] (8] [9]

1 [11] 12 [13 [14 15 19
unch

[17] [18] 19jw/Bill 20 [21] 22 (23]

24 [2_5‘ [26] 27 28 29 30

31

Iﬂ-‘ I S ] @tents l Calendar L

To display the next or You can also write in the Calendar Month view.
previous months, tap here.
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Working with Objects

Notebook contains five types of objects: recognized text objects, recognized shape
objects, ink objects that have not been recognized (both handwritten text and
freehand drawings), buttons that display pages, and objects you create with another
application and embed in Notebook.

When you tap an object to select it, the object is displayed in a box with handles and
a border. You use the handles and borders to change the object’s size or location in
Notebook. For example, you can move ink on a page by selecting the object and
dragging a border.

Moving Objects on a Page

You move an object by tapping the object to select it, and then dragging its border.
When you drag the object border, a four-headed arrow pointer and an outline of the
object border follow the pen tip.

1. To move an object, tap
the object to select it.

— otepoo Xo & v A‘
Page Edit Format Options Help

IEEEICI==cItImC]i:

2. Press and hold the pen tip on the
object border, and drag the outline.

3. When the outline is where you want
to move the object, lift the pen.
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Changing the Size of an Object

Each object has a size handle, which is indicated by a dot. You can change the size

of an object by tapping the object to select it, and then dragging the appropriate size
handle. When you drag a size handle, a double-headed arrow pointer and outline of
the object border follow the pen tip.

1. To change the size of an object,
tap the object to select it.

Notebook - Schedules [v]a
Page Edit Format Options Help

EESRN=1E | [# [Addl_ ][3I [2 )Y [B[7]u]
(A) =

®
#0773

: LContents Calendar| | I I ]

2. Press and hold the pen tip on a size 3. When the outline indicates
button, and then drag the outline. the new size, lift the pen.

When you change the size of a recognized text object, the text within the object
retains its size; the text is not enlarged or reduced to fit the new object size. An ink
object, however, enlarges or reduces to fit the new size.
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" Help with Objects

The table below describes other things you can do with objects and shows where to
find the information in Notebook Help.

To get Help on objects, you must be using Notebook.

For information on See Help topic
Adding style, color, and Working with Objects
patterns to draw objects Adding Borders and Fill to Objects
Stacking objects in layers Working with Objects
Moving Objects between Layers
Using Object Linking and Working with Objects
Embedding to insert objects Inserting and Removing Objects
from other applications
Using Object Linking and Working with Objects
Embedding to import files Importing Files as Objects
from other applications
Changing objects that have Working with Objects
been inserted or imported from Editing Objects

other applications

Guide to Pen Computing




Chapter9 Using Microsoft Notebook 143

Printing a Notebook Page

You can print selected Notebook pages or the Notebook Table of Contents, but you
cannot print a calendar page. The following illustration shows you how to print a
range of Notebook pages.

2. If you choose Print from
the Table of Contents, you

1. To print Notebook pages, choose see this dialog box. Tap
Print from the Page menu. an option, then tap OK.
=] O D00 d < O O e b4 P S

mclls) Edit| Format Options Help

New Page Lg [ Arial @ IE

Name Page
Delete Page Table of G
Go to Table pf Contents
Go to Page |

& ActualPages | __OK f ||

[] Table of Contents [_Cancel | ||

Print... () Printer:  HP LaserJet lll on LPT2
Enpt Setup... [T Print Range
Xit ' O Al
= Part# questions..........._._. O Selection

= Note Page
) @:Pages

mn-n LContentsICak From:[1 To: [5_ |
Print Quality: [High| T3] Copies: [1__|

Collate Copies

3. Choose the 4. Tap OK.
pages to print.

Before you can print the pages in Notebook, you must set up and connect to a
printer.

For information on: Choosing a printer
See Help file: Printing
Topic: Setting Up a Printer

Guide to Pen Computing




144 Part3 Using Windows

Quitting Notebook

Unlike most applications, Noteboo
guaranteeing that work will not be

the page you were using when you quit.

Notebook - Table of Contents
Edit Format Options Help

New Page
Name Page
Delete Page

[——J3] [Aal ] [2 |8 [B]1]Y]

Go to Table of Contents
Go to Page
Go to Calendar

Table of Contents

Show / Hide Subpages
Go to Hepder Page
Header//fage List...

s Part # questions...

= Note Page ----

lﬂzm Contents | Calendar l
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To exit Notebook and automatically save
your work, choose Exit from the Page menu.

k automatically saves you work when you quit,
lost. Later, when you open Notebook, it displays




Punctuation

Improving Handwriting Recognition

This appendix provides information and examples of how to print characters and
improve handwriting recognition.

The illustrations in the list on the following page use numbers and arrows to show
you the order and direction in which to draw the lines or strokes that make up each
character. The examples show one or two ways to draw each character and improve
handwriting recognition; they are not the only ways you can draw the characters.
To view animated sequences that show you ways to print characters and draw
gestures, use the Learning Pen Basics tutorial. For more information, see “Learning
Pen Basics” in Chapter 3, “Using Gestures.”

For a list of general writing tips on improving handwriting recognition, see “Writing
Tips™ at the beginning of Chapter 2, “Writing and Correcting Text.”

To improve handwriting recognition by training the computer to recognize the way
you print characters, see Chapter 4, “Training the Recognizer.”

Some characters used for punctuation, such as the comma and semicolon, can be
confused with other characters, such as the apostrophe and the letter “i.”

To avoid confusion, do the following:

®  For commas and apostrophes, use letter guides (in the Edit Text dialog box) and
keep the commas near the bottom and apostrophes near the top of the boxes.

m  For colons and semicolons, draw the top dot first.

Printing Accented Characters

To make it easier to recognize accented characters (such as “é”), do either of the
following:

®  One language: From the Control Panel, choose International, and then choose
your language from the Language list box.

®  More than one language: From the Control Panel, choose Handwriting, and then
choose the Recognizer button. In the Recognizer dialog box, select the Recognize
Characters from All Languages option.

To draw an accented character, first draw the character and then draw the accent

above it. For example, to print an “é,” you first print an “e,” and then you print the
accent.
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Glossary

A

Active Describing the window or icon that you are currently working with.
Microsoft Windows always applies the next keystroke or command to the active
window. If a window is active, it appears in front of all other windows on the
desktop, and its title bar changes color or shade to differentiate it visually from other
windows.

Inactive is the opposite of active and describes windows or icons on the desktop that
are not in use.

Active application The computer program that you are currently working with, or
an application that is running in the background.

Application A computer program used for a particular kind of work, such as word
processing. This term is often used interchangeably with “program.”

Application window An application’s main window, which contains the
application’s menu bar and work area. An application window may contain multiple
document windows. See also Window.

Associate To identify a filename extension as belonging to a certain application so
that when you open any file with that extension, the correct application is opened
automatically.

Browse To look through files and directories. In some dialog boxes, you tap the
Browse button to view a list of files and directories so you can then select the file
you want.

(¥

Cell One unit of a letter guide in the writing window. You turn letter guides on to
improve character recognition or to print in applications that do not accept pen input
directly.

Check box A small square box that appears in dialog boxes and that you can select
or clear. You select a check box by tapping it. When the check box is selected, an X
appears in it. |

Choose To select a command in Microsoft Windows. You often choose a command
from a menu after you have selected or made active the item to be acted upon. |
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Clear To turn off an option by removing the X from a check box. You clear a check
box by tapping it.

Command A word or phrase, usually in a menu, that you choose to carry out an
action. You choose a command from a menu by tapping the menu name and then
tapping the command.

Command button A button that you tap to carry out or cancel a command.

Communications settings Settings that specify how information is transferred from
your computer to a device (usually a printer or modem).

Control menu The menu at the left end of the title bar, indicated by a SPACEBAR
icon. Use the Control menu to minimize and maximize a window, or to close an
application.

Control Panel The Windows application that sets pen-tapping speed, ink width, ink
color, dictionary choice, recognition modifications, and user lists. The Control Panel
is in the Main group.

Current directory The directory that you are currently working in.

D

Default button The command button that in some dialog boxes is automatically
chosen by Windows as the most logical or safest choice. You can override a default
button by choosing Cancel or another command button.

Default printer The printer that a Windows application will automatically use when
you choose the Print command. You can have only one default printer, and it should
be the printer you use most often.

Desktop The background of your screen, on which windows, icons, and dialog
boxes appear.

Desktop pattern A geometric pattern that appears on your desktop. You can design
your own pattern or choose one of the patterns provided by the Windows
environment.

Destination directory The directory to which you intend to copy or move one or
more files.

Device driver A program that enables a specific piece of hardware (device) to
communicate with Windows for Pen Computing. Although a device may be installed
on your system, Windows will not recognize the device until after you have installed
and configured the appropriate driver. Device drivers usually have the extension
.DRV.
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Dialog box A rectangular box that requests or provides information. A dialog box
typically presents options for you to choose from before Windows carries out a
command.

Dimmed Unavailable, disabled, or grayed. A dimmed button or command is
displayed in light gray instead of black, and it cannot be chosen.

Directory Part of a structure for organizing your files on a disk. A directory can
contain files and other directories (called subdirectories). The structure of directories
and subdirectories on a disk is called a directory tree.

Directory window A File Manager window that lists the contents of a disk. The
window shows both the directory tree and the contents of the current directory. A
directory window is a document window that you can move, size, reduce, or enlarge.

Document Whatever you create with an application, including information you
handwrite, edit, view, or save. A document can be a business report, a spreadsheet, a
picture, and so on.

Document file A data file that is associated with an application. When you choose a
document file, the application starts and opens the file.

Document-file icon A drawing representing a file that is associated with an
application. When you choose a document file, the application starts and opens the
file.

Document window A window inside an application window. Each document
window contains a single document or other data file. There can be more than one
document window inside an application window.

Double-tap To tap the pen twice quickly against the writing surface.
Drag To move an item on the writing surface by holding down the pen tip on the
item while moving it to wherever you want it. For example, you can move a window

to another location by dragging its title bar.

Drive icon An icon in a directory window in File Manager that represents a disk ‘
drive on your system. Different icons depict floppy-disk drives, hard-disk drives,
network-disk drives, RAM drives, and CD-ROM drives. ‘

Drop-down list box A single-line list box that opens to display a list of choices
when you tap the arrow in the box.

E

"Electronic ink" Lines that appear on the writing surface or screen as you print or |
draw with the pen.
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Embedded object An “object” inserted into a document. You can edit the object
(which can be text, a chart, or a drawing) from within that document even if a
different application was used to create it. See also Object.

Extension Part of a file or directory name appearing after a period. The extension
can provide additional information. It usually indicates the type of file or directory.
For example, program files have default extensions of .COM or .EXE.

Many applications include a default extension automatically when you save a file the
first time. For example, Notepad adds .TXT to all filenames unless you specify
otherwise.

F

File A document or application that has been given a name. All documents are
stored as files in Microsoft Windows.

Filename The name of a file. Microsoft Windows uses MS-DOS naming
conventions.

Floppy disk A disk that can be inserted in and removed from the computer’s disk
drive.

Font A graphic design applied to numerals, symbols, or letters of the alphabet. A
font usually comes in different sizes and styles, such as bold, italic, and underlined.

Fontset A collection of font sizes for one font, customized for a particular display
and printer. Font sets determine what text looks like on the screen and when printed.

Footer An identifying word or phrase that appears at the bottom of every page of a
document when it is printed.

G

Gesture A symbol you draw that represents a command. Some gestures in
Windows for Pen Computing have been predefined and are unchangeable; others the
user can change. In addition, users can define their own gestures.

Group A collection of applications within Program Manager. Grouping your
applications makes them easier to find when you want to start them.

Group icon The icon that represents a group in Program Manager. To open a group
and view its contents, you tap the group icon.

Group window A window that displays the items in a group within Program
Manager. These items can be applications, files associated with applications, or a
combination of both.



Glossary 155

H

Header An identifying word or phrase that appears at the top of every page of a
document when it is printed.

Icon A graphical representation of a disk drive, a directory, a group, an application,
a document, and so on. You can enlarge an application icon to a window by double-
tapping the application icon.

Insertion point The vertical blinking bar where text can be inserted.

L

Letter guides Individual cells used to separate characters in the writing window.
You use letter guides to improve character recognition and to handwrite in
applications that do not otherwise accept pen input.

Linked object A marker or placeholder representing an object that is inserted into
the destination file. The object still exists in the source file and, when it is changed,
the linked object is updated to reflect the change.

Listbox A box within a dialog box that lists available choices—for example, the
list of all available files in a directory. If all the choices do not fit in the list box, the
list box includes a vertical scroll bar. Some list boxes allow you to select more than
one item.

Local printer A printer that is part of your computer system; it is directly connected
to one of the ports on your computer.

Maximize button The small button at the right end of the title bar containing an Up
arrow. You enlarge a window to its maximum size by tapping the Maximize button.

Memory A temporary storage area for information and applications.
Menu A list of available commands. Menu names appear in the menu bar near the
top of the application window. You choose a command by tapping the menu name

on the menu bar and then tapping the command you want.

Menu bar The horizontal bar containing the names of all the application’s menus. It
appears just under the title bar.

Menu command A word or phrase in a menu that you choose to carry out an action,
such as copying a file.
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Menu title A word or phrase in the menu bar that identifies a group of commands.
Selecting the menu title causes the title to be highlighted and its menu of commands
to appear below it.

Minimize To shrink a window to an icon.

Minimize button The small button at the right end of the title bar containing a
Down arrow. Tap the Minimize button to reduce a window to an icon.

0

Object Any piece of information created using a Windows application. A text
paragraph in Write, a single cell of an Excel spreadsheet, or an entire Paintbrush
drawing are objects. See also Embedded object and Object linking and embedding.

Object linking and embedding A way to transfer and share information between
applications.

Online Help Assistance regarding numerous aspects of an application that can be
found online—that is, within the system rather than in printed materials.

On-screen keyboard A miniature keyboard that is displayed when you tap the
Keyboard button. In most cases you can use this keyboard to replace a regular
keyboard. You “type” letters by tapping them. To carry out key combinations, tap
the keys in sequence. To select different keyboard layouts, choose Options from the
Control menu of the on-screen keyboard.

Open To display the contents of a directory, a single document, or a data file in a
window, or to enlarge an icon to a window. You can open windows that list the
contents of groups or directories, and windows that display the contents of a specific
file. Opening a file refers to opening a document file you created with an
application.

Options button A small round button that appears in a dialog box and is used to
select an option. Within a group of related options buttons, you can select only one
button.

P

Package An icon that contains either embedded or linked information. When you
select the icon, the contents of the icon are displayed.

Path The route to a file within the directory tree. See also Pathname.

Pathname The directions given the computer for finding a directory or file within
your system. For example, CAWINDOWS3WAPPTSVUNE.CAL is the pathname of
the JUNE.CAL file in the APPTS subdirectory in the WINDOWS3 directory on
drive C.
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Pen Palette A palette of pen tools. The Pen Palette includes the Edit menu, writing
window, on-screen keyboard, trainer, and buttons for clearing and inserting text.

Pointer The arrow-shaped cursor on the screen that follows the pen’s movement on
the screen. The pointer changes to a pen in areas where you can write.

Printer driver A program that controls the way your printer works. The printer
driver accepts instructions from Print Manager and then interprets them so that your
printer can print your documents correctly.

Printer fonts Fonts that are built into your printer. These fonts usually reside in
your printer’s read-only memory (ROM).

Program file A file that starts an application or program. A program file has an
.EXE, .PIF, .COM, or .BAT filename extension.

Program items The applications and documents that make up a group in Microsoft
Windows. Program items are represented as icons in a group window.

Program-item icon The icon that represents an application in Program Manager.
You can start an application by double-tapping its program-item icon.

Program Manager A major management tool of Microsoft Windows. Program
Manager appears immediately when the Windows environment is opened and
contains several groups essential for the various programs and applications.

Q

Queue A list of documents that are currently printing on a printer.

RAM  The acronym for random-access memory. RAM can be read from or written
to by the computer itself, or by other devices. Information stored in RAM is lost
when you turn off the computer.

Recognition The process of converting handwriting to type.

Recognizer The system that interprets your handwriting.

Reduce To minimize a window to an icon at the bottom of the desktop by using the
Minimize button or the Minimize command. The document or application remains
open (or running), and can be the active application or document.

Restore button The small button at the right end of the title bar containing both an
Up arrow and a Down arrow. The Restore button appears only after you have

enlarged a window to its maximum size. Tap the Restore button to return the
window to its previous size.
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S

Scroll  To move through text or graphics (up, down, left, or right) to view parts of
the file that cannot fit on the screen.

Scroll arrow  An arrow on either end of a scroll bar that is used to move the
contents of the window or list box. Tapping a scroll arrow moves the contents one
line or one screen. Pressing a scroll arrow scrolls the contents continuously.

Scroll bar A bar that appears at the right and/or bottom edge of a window or list
box when the contents of the window or list box aren't completely visible. Tap the
down arrow at the bottom right edge of the window to scroll slowly down a help
topic. Tap in the scroll bar above or below the box to scroll one screen at a time.

Scroll box A small box in a scroll bar that shows the position of what’s currently in
the window or list box relative to the contents of the entire window.

Select To mark an object such as a character, word, or picture by highlighting it.
After selecting an object, you choose the action you want to affect it. To select text,
press the pen against the screen until the cursor changes to a down arrow, then drag
over the text you want to select. To select an object, such as a drawing, tap it.

Selection cursor The marking device that shows where you are in a window, menu,
or dialog box and what you have selected. The selection cursor can appear as a
highlight or as a dotted rectangle around the text in a dialog box option.

Source directory The directory containing the file or files you intend to copy or
move.

Splitbar The bar that divides a directory window in two parts: The directory tree is
displayed on the left, and the contents of the current directory are displayed on the
right.

Status bar A line of information located at the bottom of a window. For example,
in a directory window the status bar displays how many files are selected, how much
disk space they occupy, and the total number of files in the directory (whether
included in the directory window or not). In File Manager, the status bar shows the
number of bytes available on the disk and the total disk capacity. Not all windows
have a status bar.

System disk A disk that contains the DOS system files necessary to start DOS.
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T

Tap To press the pen tip against the screen and lift the pen tip up.

Task List A window that shows all the running applications. Use the Task List to
switch between running applications. You display the Task List by double-tapping
on an empty area of the window background.

Textbox A box within a dialog box where you print information needed to carry
out a command. When the dialog box appears, the text box may be blank or it may
contain text.

Text object Handwritten text that has been recognized and thus can be acted
upon—edited, moved, or copied.

Title bar The horizontal bar at the top of a window. You move a window by
dragging the title bar.

Trainer A button on the Pen Palette tool bar. Use the trainer to teach the recognizer
to recognize your handwriting and gestures.

W

Wallpaper A picture or drawing stored as a bitmap file (a file with the extension
.BMP). Bitmaps can be simple drawings or elaborate scanned photographs.

Warning beep The sound that your computer makes when you encounter an error or |
try to perform a task that the Windows environment does not recognize.

Wildcard A keyboard character that can be used to represent one or many
characters. The question-mark (?) wildcard can be used to represent any single
character, and the asterisk (*) wildcard can be used to represent any number of
characters.

Window A rectangular area on your screen in which you view an application or
document. You can open, close, and move windows, and change the size of most
windows. You can open several windows on the desktop at the same time and you
can reduce windows to icons or enlarge them to fill the entire desktop.

Window border The border that surrounds a window. You change the size of a
window by dragging the border.

Windows application An application that was designed for Microsoft Windows and
does not run without Windows. All Windows applications follow the same
conventions for arrangement of menus, style of dialog boxes, use of the keyboard,
pen, and so on.
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A

Accessories 115
Accessories group window

contents of 100

starting an application in 79
Activating a window 82-84
Adding

a space when printing 14

new text 17

pages to Notebook Table of Contents 130
Annotating a Help topic 73
Application(s)

defined 7

exiting 90

icons, defined 2

moving to group window 100-102

non-pen-supporting 40

printing in 35

starting 7, 79

working with several at once 81-84
Applications group window See Group window
Arrow pointer 8

Back button (Help) 72

Backspace gesture 53

Backtrack button (Notebook) 116-117

Barrel button on pen, using to erase in Notebook 121
Bookmarks to mark Help topics 73

Border of window, dragging to resize window 81
Buttons See specific buttons

¢

Calculating (Notebook) 128-129

Calculator application icon in Accessories group
window 100

Calendar (Notebook) 138-139

Calendar application icon in Accessories
group window 100

Cancel button 88

Character(s)
improving handwriting recognition 145
incorrectly recognized 63
one incorrectly recognized as two 65
printing 33-36
recognition of 63
Check box 88-89
Choosing
See also Selecting )
acommand 86
amenu 86
Circled-letter gestures 59-61
Clear button
described 19
using to clear writing window 22
Clipboard
contents pasted in new location 56
storing copied text 56
storing cut text 16
Closing
a document or application 100
the Sample Form 17
Collapsing page levels (Notebook) 135
Command buttons 88
Commands, choosing 86
Configure button for hardware settings 92
Contents button (Help) 72
Control menu 80
Control Panel 91-98
Copy gesture 56
Copying text between windows 81-84
Correcting errors
described 37-39
in letter guides 10
using Edit Text dialog box for 14
using writing window for 43
with gestures 12-17
Creating gestures 59-61
Current page button (Notebook) 116-117
Customizing the recognition database 66
Cut gesture 54
Cutting text 16

Guide to Pen Computing




162 Index

D

Defining gestures 59-61
Definitions
how to find in Help topics 71
of terms and concepts 151
Delete gesture 57
Delete Word gesture 57
Dialog box, contents of 88-89
Dictionary button 88
Dictionary setting for additional dictionary 93
Dimmed boxes 88
Directory, using 104-107
Disk drives shown in File Manager 104-105
Display, adjustment to horizontal or vertical 98
Document
exiting 90
saving 89
Dots (ellipses) following names of buttons 88
Double-tap settings, modifying area or speed of 92-93
Double-tapping 3
Dragging text 3
Drawings, freehand, in Notebook, recognition of 123

E

Edit menu 19-20
Edit Text dialog box
described 13
making corrections in 13-14, 38-39
Edit Text gesture
described 52
using in Notebook 124
Electronic ink
See also Objects (Notebook)
adjusting in relation to pen 97
adjusting width and color settings for 92-93
as text and shape objects in Notebook 120
defined 35
erasing or deleting in Notebook 121
tracked by trainer 63
Ellipses following names of buttons 88
Errors See Correcting errors
Exiting
a document 90
an application 90
Help 28
Microsoft Windows 102
Notebook 144
Program Manager 102
Expanding page levels (Notebook) 135
Extend Selection gesture 58
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F

File Manager
See also File(s); Filenames
Using 104-111
File(s)
See also File Manager; Filenames
copying 109-110
defined 89, 104
finding 108
icons 107
moving 109-110
saving 89
Filenames
See also File Manager; File(s)
explained 107
Finding text (Notebook) 126
Font box (Notebook) 116-117
Font size box (Notebook) 116-117
Fonts (Notebook) 127
Formatting text (Notebook) 127
Freehand drawing in Notebook
Notebook freehand tool 116-117, 122
recognition of 123

G

Games 98, 113

Gestures
Backspace 53
button (Help) 72
Copy 56
creating 59-61
Cut 54
defined 49
Delete 57
Delete Word 57
Edit Text 52
Extend Selection 58
Help in finding predefined 50
how translated into actions 49
Insert New Line 54
Insert Space 53
Insert Tab 58
Manager 59
Paste 56
predefined 52-58
predefined circled-letter 59
tips on drawing 52-58
Undo 55
user-defined 59
using 49-61
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Group window
accessories 79
creating 100-102
defined 2
overview 99-102
using 79

H

Handles (Notebook)
page 132
size 141
Handwriting recognizer See Recognizer
Handwriting settings 95
Header pages (Notebook)
creating 133-134
defined 132
Help, how to use
See also Help topics; Help topics (Notebook);
Learning Pen Basics tutorial
brief discussion 23-29
button 19, 72, 88
complete discussion 67-73
exiting 74
features not covered in this book, how to find 74
Help Contents 67-70
menu 69
notes in this book, how to use 29, 68
scrolling through Help 69
Help topics
See also Help, how to use; Help topics (Notebook);
Learning Pen Basics tutorial
Control Panel 67, 97
File Manager 67, 111
for a specific application 67
for calibrating the pen 97
for choosing preferred dictionary 98
for choosing preferred recognizer 98
for correcting text 39
for customizing shapes in recognizer 66
for defining user’s own gestures 61
for international settings 98
for pen basics 44
for rotating a window display 97-98
for starting applications 79
for the on-screen keyboard 46
for viewing gestures 50
for writing in the writing window 42
Pen Palette 67
Print Manager 67, 113
Program Manager 67, 103

Help topics (Notebook)
See also Help, how to use; Help topics; Learning
Pen Basics tutorial
for adding pages 137
for adding style, color, patterns to draw objects 142
for choosing a printer 143
for creating a button to display a button 119
for selecting, hiding, and changing page levels 136
for stacking objects in layers 142
for using gestures in Notebook 129
for using object linking and embedding 142
for working with ink or recognized objects 123
Highlighting See Selecting
History button (Help) 72
Horizontal display 98

Icons 2

Ink See Electronic ink
Insert New Line gesture 54
Insert Space gesture 53
Insert Tab gesture 58
Insertion point 80
International settings 98

K

Keywords in Help topics 73

L

Landscape display 98

Learning Pen Basics tutorial 50-51
Left-handed writer See Writing hand
Letter guides 9-11

List boxes 88

Main group window, contents of 100

Managers (File, Program, and Print) in
Microsoft Windows 99

Maximize button 80

Menu bar 80

Menu style for left- or right-handed writer 95

Menu, choosing 86

Microsoft Alphanumeric Recognition System 33

Microsoft Notebook See Notebook

Microsoft Paintbrush 100

Microsoft Pen Tools group window 100
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Microsoft Windows
basic skills for 77-90
customizing 91-97
exiting 102
managing 99-113
multiple windows, advantages of 81
using a pen with 77-90
Microsoft Word for Windows, predefined
gesture in 59
Microsoft Write
starting 79
in Accessories group window 100
predefined gesture in 59
Minimize button 4
Minimizing a window 4, 81-82
Mistakes See Correcting errors
Mouse, similarity with pen 1
Moving
a window 5, 85
an application to a group window 101-102
objects (Notebook) 140
pages (Notebook) 136
text between windows 81-84

Names of files and directories 107
Naming pages (Notebook) 131
Navigation bar (Notebook) 116-119
New page button (Notebook) 116-117
New text 17
New user, adding 96
Next page button (Notebook) 116-117
Notebook

automatic saving ability of 144

buttons 116-117

starting 116

tool bar 116-117

using 115-144

0

Objects (Notebook)
described 140
working with 140-142
OK button 19, 88
On-screen keyboard
key combinations in 45
“typing” in 21
use of 21,45
On-Screen Keyboard button 19
Option buttons 88-89
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Options
dimmed 88
in dialog boxes 88
Organizing Notebook pages by level 132

P

Page name box (Notebook) 116-117
Page number button (Notebook) 116-117
Page tabs (Notebook)
creating 119
described 116-117
Pages (Notebook)
adding to Table of Contents 130
deleting 137
moving 136
naming 131
organizing by level 132
Paste gesture 56
Pen
calibration of 97
learning to use 1-30
pointer 8
with Microsoft Windows 77-90
Pen Basics button (Help) 72
Pen Palette
closing 46
defined 2
minimizing 22, 46
restoring 18
tools 21
writing window 41
Pen settings for modifying ink and
double-tap response 92-93
Pen tools 100
Personalized handwriting settings 95
Pointer
arrow-shaped 8
as indicator of pen-aware application 35
pen-shaped 8
Portrait display 97-98
Predefined gestures
demonstrated in tutorial 50-51
encircled letters 59
supplied with Windows for Pen Computing 52-58
Press and Hold time delay for selection time
adjustment 94
Previous page button (Notebook) 116-117
Print Manager 111-113
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Printing (handwriting)

See also appendix; Correcting errors; Recognition

in an application 8

in Edit Text dialog box 14

in letter guides 9

in Notebook 120-122

over errors 10

tips 33-34, 36

without letter guides 11
Printing documents and files See Print Manager
Printing Notebook pages 143
Program Manager

additional uses of 103

described 2, 4-6, 78

exiting 103

opening screen of 2

starting applications in 6-7, 79

using to create group windows 99-101
Program-item icons 99

Q

Quitting See Exiting

Recognition
See also appendix; Recognizer
database, customizing 66
of characters, improving 36, 63
of different handwritings, setting for 95
of freehand drawings in Notebook 123
of gestures 49
of printing in Notebook 122
system other than Microsoft’s 63, 66
time, adjusting 96
Recognize text button (Notebook) 116-117
Recognizer
See also Recognition
adjusting recognition time of 96
button 88
described 35
how translates gestures 49
how translates printing 35
incorrectly identifying characters 64-65
incorrectly identifying gestures 66
notifying user of shape already in use 64
setting for switching languages 98
training 64-66
using more than one 66, 98
when to use 63
with new user 96

Recognizer button 88
Relative size of printing to text in Notebook 122
Replacing text 17, 38
Resizing a window 6, 85
Restoring
a window 5
an application 81
the Pen Palette 18
Rotating the vertical or horizontal display 98

)

Sample characters 33, 63, 145
Sample Form 7-17
Saving documents and files 89
Screen, opening, for Microsoft Windows 2
Scroll bars 80, 88-89
Scroll boxes 88-89
Search button (Help) 72
Search command, using to find Help topics 73
“Select and Choose™ method for commands 87
Selecting
adjusting press and hold time for 94
described 15
text in a document 87
text in Notebook 125
Shape tool (Notebook) 116-117
Shortcuts, double-tapping to get 3
Side button on pen See Barrel button
Size box (Notebook) 116-117
Size of recognized text in Notebook 122
Sizing
a window 6, 85
objects in Notebook 140
Starting an application 7, 79 |
StartUp group window 100
Subdirectory ‘
contents, viewing 106 ,
described 104-105 |
Subpages (Notebook)
creating 133-134
defined 132 |

T

Table of Contents (Notebook)
identification of elements of 116
using 118
working with 129-137

Tapping 3

Task list 84 I

Terms, definitions of 151 I
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Text boxes 36, 88-89
Text objects (Notebook)
See also Objects (Notebook)
defined 124
Text style buttons (Notebook) 116-117
Text styles (Notebook) 127
Text tool (Notebook) 116-117
Text type box (Notebook) 116-117
Tips, drawing
See also appendix; Gestures; Printing tips
gestures 52-58
Title bar, using to move window 5, 80
Tool bar
Notebook 116
Pen Palette 19
Tools window 80
Topics See Help topics
Trainer 63
Trainer button 19
Training the recognizer 63-66
Translating printing into text in Notebook 122
Tutorial, Learning Pen Basics 50-51
“Typing” in on-screen keyboard 21

U

Undo gesture 55
Undoing an action (Notebook) 128

Undoing recognized text or shapes (Notebook) 122

User-defined gestures 59

User options for personal handwriting settings 95

Users, adding 96

vV

Vertical display 97-98

W

Window(s)
See also Microsoft Windows
borders, use of 81
choosing from the Task List 84
defined 78
group 99-101
tools 80
working with several at once 81-84
Workspace 80-81

Writing See Pen Palette; Printing; Writing hand;

Writing window
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Writing hand
menu style for 95
setting for 95
Writing tools See Pen Palette
Writing window
button 19
clearing text from 22
correcting text in 43
on-screen keyboard in 21
Pen Palette 41-44
sending text from 42
use of 20
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